Control Nesting Manual
Table Of Contents

Control Nesting ............................................................................................................. 1
Introduction ..................................................................................................................... 1
Specifications ................................................................................................................. 2
Operation ........................................................................................................................ 2
Job Level Interface ........................................................................................................ 3
Feed Speed Settings ..................................................................................................... 5
File menu ......................................................................................................................... 7
  Load ............................................................................................................................... 7
    Loading Files .............................................................................................................. 7
    eCabinet Systems Files (*.twd) .................................................................................. 7
    DXF Files ................................................................................................................... 8
    DXF Part List ............................................................................................................. 9
    Cut Planner Files (CPOUT) ....................................................................................... 11
    Excel Files ............................................................................................................... 11
    Recut Part Entry ...................................................................................................... 13
    Manual Panel Input ................................................................................................... 13
    Material Database .................................................................................................... 13
    Clear All .................................................................................................................... 14
    Scrap Part Recovery ................................................................................................. 14
    Selection Filter ......................................................................................................... 14
Printing ............................................................................................................................ 15
Export .............................................................................................................................. 25
Save/Load Settings/Tooling .......................................................................................... 26
Database Directories ..................................................................................................... 26
View menu ....................................................................................................................... 27
  Screen Properties ....................................................................................................... 27
  Manual Nest Toolbar ................................................................................................. 27
Edit menu ......................................................................................................................... 29
  Settings ......................................................................................................................... 29
    Settings ....................................................................................................................... 29
    Settings Grouping ...................................................................................................... 29
    Quick Cut Options .................................................................................................... 31
    Dimension Format .................................................................................................... 33
    Table Parameters ...................................................................................................... 33
    Machine Settings ...................................................................................................... 34
    Pocket Settings ......................................................................................................... 43
    Cut Parameters ......................................................................................................... 46
    Tabbing Parts ............................................................................................................ 54
    Nesting Parameters ................................................................................................. 58
    CNC File Path .......................................................................................................... 62
Tooling ............................................................................................................................... 63
  Tooling .......................................................................................................................... 63
  Select Tool Tolerance ................................................................................................. 64
  Tooling Group ............................................................................................................. 65
  Copy/Paste .................................................................................................................... 65
  Group Materials .......................................................................................................... 65
  Ignore Groups ............................................................................................................... 65
  Outline Tool Setup ...................................................................................................... 65
  Operation Tool(s) Setup .............................................................................................. 66
  Confirmation Screen .................................................................................................... 70
  Drill Bank Configuration .............................................................................................. 71
  Pocket Screw ............................................................................................................... 72
  Material ......................................................................................................................... 72
Until Control Nesting version 5.0, all profiling done in eCabinet Systems with the Part Editor had to be machined using the Profile Modeller. This meant that all parts needed to be done on a one by one basis. Now with Control Nesting v5.0 and up, profiled parts can be nested and cut out using the same technology available with Profile Modeller. Since it uses Profile Modeller functionality you must have Profile Modeller installed on the Controller. If the Controller do not have Profile Modeller version 2.0 or higher installed Control Nesting will not support Profiling. If you start Control Nesting and see (With Profile Modeler) stated at the top of the dialog. You have the correct versions installed. This must be present to function.
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Labels</td>
<td>115</td>
</tr>
<tr>
<td>Datamax-O'Neil Configuration</td>
<td>115</td>
</tr>
<tr>
<td>Label Printer Tools</td>
<td>115</td>
</tr>
<tr>
<td>Label Recovery</td>
<td>116</td>
</tr>
<tr>
<td>Auto Labeling</td>
<td>117</td>
</tr>
<tr>
<td>Label Machine</td>
<td>119</td>
</tr>
<tr>
<td>Label Machine (Interrupted)</td>
<td>121</td>
</tr>
<tr>
<td>AFL</td>
<td>125</td>
</tr>
<tr>
<td>AFL</td>
<td>125</td>
</tr>
<tr>
<td>OPENCN</td>
<td>125</td>
</tr>
<tr>
<td>WAITCN</td>
<td>126</td>
</tr>
<tr>
<td>Manual Nesting</td>
<td>131</td>
</tr>
<tr>
<td>Glossary</td>
<td>135</td>
</tr>
<tr>
<td>Index</td>
<td>137</td>
</tr>
</tbody>
</table>
Introduction

Control Nesting is a nesting package integrated into the Thermwood Software. This package allows the user to nest various parts into sheet stock, thus creating a user-friendly program. Some benefits of this particular package include better yield, mixing of different parts, label printing for the parts as well as off-fall, ability to re-use off-fall, etc. It will also display a graphical view of the nest to insure it will suit the user’s needs along with a yield percentage per sheet stock.
Specifications

Control Nesting is compatible with Thermwood Software versions 5.0 and later. It can be used in conjunction with eCabinet systems software to quickly nest and generate CNC programs from the provided TWD files. Control Nesting can also be used to nest DXF part files that are generated from almost any CAD/CAM system, Cut Planner Files which are generated from software called Pattern Systems, and Manual Panel entry.

Definition: Off-fall = Usable scrap leftover from an operation.

Operation

The user may activate Control Nesting from the Thermwood Software by pressing F11 (THM Options) then F2 (Rolling Nest) on the keyboard or by selecting F10 (Main Menu), F5 (File), then F1 (Load File) and loading the particular TWD file.

On versions of THM that have the Windows menu at the top then the options for starting Control Nesting are by clicking the thumbnail or loading the twd file.

When started a dialog box will appear resembling the following picture:
Job Level Interface
Jobs can be loaded by 1 file from supporting software. Currently the supporting softwares are eCabinet Systems (twd file), CabinetVision (mdb file), CabinetWare (mdb file), KCDw (mdb file), and 20/20 (cab file). These files are loaded in the Load dialog.
Some jobs such as MDF Doors can require special tooling. For these jobs the tool recognition is done by using Tool Names. Go to Tooling to designate these tools. Clicking on Current Tool Names button will open a dialog specifying the tool names in the currently loaded job. If the job does not contain any tool name then this dialog will not display. These tool name can be copy/paste into the Tool Name entry box for the appropriate operation tool. Now Control Nesting will select this tool for the appropriate operation in the job.
Feed Speed Settings
All feed speed values in Control Nesting should be in the format of the machine. Control Nesting format is not used with feed speeds.
File menu

Load

Loading Files

Clicking on the “Load” button will bring up the Load dialog which is the interface used to load all compatible files into the Control Nesting Software. The large, white window on the left contains the current parts ready to be nested. The column to the right contains load and add buttons for each compatible file.

eCabinet Systems Files (*.twd)
To load a new file, press Load which is located under the heading “TWD Files” (eCabinets icon listed below). Once the window’s browser appears, the operator will need to select the correct file or files that he/she wants to load (To select multiple files, hold down Ctrl. Key when selecting). Once the selection has been made a list of parts will then appear in the window on the left. If the user looks closely, they will notice check marks aside of the cabinet(s) name and individual parts. If the check marks are removed, that part will not be included in the nest. Then operator also has the option to change the quantity of the parts that are going to be cut. To do this, they must select the specific line containing the parts that they want to change the quantity of. Then, by pressing the “Enter” key, this will enable them to type in a new quantity. Once a file has been loaded, more files can be added by pressing the “Add” button, located under the “TWD Files” heading. To clear all parts listed in the Load Screen; press the “Clear All” button. Otherwise, when loading a TWD or DXF file the load screen will automatically be cleared.

**DXF Files**

To Load or Add DXF files, the user will need to use the Radio buttons under the heading “DXF Files” (notice DXF Files icon) and select the appropriate button. Once the DXF file or files have been selected, the operator will be prompted to enter the material information. At this point they can either choose from the pull down menu or add a material.
Upon completing the material input, the parts will be listed in the white load screen to the left. Control Nesting will allow the user to load a combination of DXF and TWD files for nesting. After the files have been loaded the user will select OK to get back to the nesting screen. Please refer to the “DXF Translator” section of this manual for specifications on creating DXF files properly in order to successfully nest them.

**DXF Part List**

Another option to load DXF files which is listed under the “DXF Files” heading is “Load DXF Part List”. This enables the operator to select an excel file that contains a list of DXF files that reside in a particular location on the controller.

The "settings" button will bring up the DXF List Settings dialog. The user can select the Field or Value they which to alter for designating the location of information in the Excel spreadsheet. The entries must all be designated only once. Duplicates are not allowed. The "Sheet Name" can be altered if the default value of "Sheet1" is not used in the spreadsheet. The option "Spreadsheet Contains Header" will tell Control Nesting to skip the first record when enabled.
Below is a description of the default Field to Value relationships.
Cut Planner Files (CPOUT)

Control Nesting also has the option to load files that are from software called Pattern Systems. “Cut Planner files (CPOUT)” allows the user to Load or Add files that originate from Pattern Systems.

Excel Files

“Excel Files” gives the operator the option to Load or Add excel files containing a list of panels that they would like to cut. This is only for rectangular panel cutting.

The "settings" button will bring up the Excel Settings dialog. The user can select the Field or Value they which to alter for designating the location of information in the Excel spreadsheet. The entries must all be designated only once. Duplicates are not allowed.
The "Sheet Name" can be altered if the default value of "Sheet1" is not used in the spreadsheet. The option "Spreadsheet Contains Header" will tell Control Nesting to skip the first record when enabled.

Below is a description of the default Field to Value relationships.
Recut Part Entry

This area is for manually entering the Recut ID located on a label for a part. Type in the Recut ID then press enter for the part to load. If it no longer exists in history then a warning will be displayed. This is an alternative method for machines without a barcode scanner. See Settings -> Cut Parameters -> Recut for more information.

Manual Panel Input

Manual Panel Input allows the operator to input custom panel sizes right at the controller and nest them.

Material Database

The Material Database button lets the operator access the material database so that he/she can input or remove materials they are using for DXF file nesting.
Clear All

To clear all parts listed in the Load Screen; press the “Clear All” button. Otherwise, when loading a TWD or DXF file the load screen will automatically be cleared.

Scrap Part Recovery

There may be times that a particular part moves during machining, resulting in a defective part. This means a single part will have to be re-machined. To do this, the operator needs to go into the Load screen and make sure that only the parts that need cut again are selected. Then, they will need to place a check mark aside of the Scrap Part Recovery option which will cause the machine to run only one part per sheet. Each part will be cut at the flip operation fence and follow the X & Y Shift settings.

The option for no outline cuts in Settings will be obeyed. If it is selected the part to be machined will need to be cut to size and can be placed in the fence location for the operations to be performed.

If the no outline cuts selection is not selected then the machine will run the outline pass. Material will need to be a size greater than the part by the diameter in width and length when the option Nest to Edge of Sheet is NOT selected. If Nest to Edge of Sheet is selected then the material does NOT need to be oversized.

The Part Rotation Step Angle option in Settings is also obeyed. For example, if the setting is 90 degrees then the part(s) will be rotated 90 degrees.

Selection Filter

The Selection Filter allows for nesting only certain materials in the currently loaded items. By selecting a material(s) in the drop down list the appropriate parts will be selected in the tree for nesting. By choosing "All Materials" all parts will be selected in the tree for nesting. Settings are applied when the Apply button is pressed.
Printing

If the operator wants to print labels and a nest layout, they can select the “Print” button and the following dialog box will appear.
**Printing Sheets:**

Selecting the option "Print Per Sheet When Cutting" will enable Control Nesting's ability to print a single sheet of the currently cutting sheet. The printing will begin when the Start button is pressed to begin cutting that particular sheet. NOTE: This option only
works properly when the program running is the last program that was generated by Control Nesting.

Print Sheets will perform the printing for the selected Sheet Settings.

Print to Window will create bitmaps of printed sheets and put them in the c:\Rolling Nest\SheetImages directory. Then they are displayed using Windows Picture Viewer.

Sheet Settings will take you to the following dialog where options for the printed sheet can be set.

Print Barcodes offers a barcode to be printed on the page. These barcodes can be scanned to print a single label or to re-print the page using the Label Recovery option in Thermwood Control Software. (requires Thermwood Control Software version 8.3.0 or newer).

NOTE: When using the "Use Part Name on Parts" option you must keep in mind that if you have parts with long names it could appear messy. Plus if the nest contains multiple parts with the same name it will be difficult to depict where a part is located in the nest. This option is recommended for jobs with simple unique part name strategies.

![Print Sheet Settings dialog]

**Printing Labels:**

Print Labels will bring up a dialog box to perform label printing. The labels will be printed based on the Crystal Report file selected. Click the Select File button to select a Crystal Report file. The files provided with Control Nesting are located in the C:\Rolling Nest\Labels directory.
Auto Options

"Print Per Sheet When Cutting" will enable Control Nesting's ability to print only the labels for the current sheet prior to cutting each sheet. The printing will begin when the Start button is pressed to begin cutting that particular sheet. NOTE 1: This option only works properly when the program running is the last program that was generated by Control Nesting OR the program is a CNC Database. (Only available with THM 7.6 or newer.)

"Print & Apply With Machine" will enable the machine labelling feature. If a machine is equipped with a labeling device it will automatically print and place the labels on each part prior to cutting each sheet. (Only available with THM 8.3 or newer with PLC version 2.0.3 or newer.)

"Print & Apply With Auto Processor" will enable the auto processor labelling feature. If your machine is an Auto Processor this setting is required to inform Control Nesting that an autoloader with labeling device is attached and ready for printing labels, placing labels, and loading sheets. (Only available with THM 8.3 or newer with PLC version 2.0.3 or newer.)

The values Label Width, Label Length, and Min. Clearance from Part Edge or Cuts are used for placing labels on parts. They are only needed for the Print & Apply With Machine and Print & Apply With Auto Processor options. These values do not affect the rpt that is used for the printing. It is up to the user to insure that the size values match the actual labels that are printed. This insures that there is room for the label and it will not get cut into. If a label does not fit on the part it is not placed.

The following is a list of the available Crystal Report files with a label type and an example of the data they display per label.

NOTE: Files with the word "Barcode" in the title will only print labels with barcodes. Files with the work "Recut" in the title will include a barcode on each part label that can be scanned for loading to recut.

30252_Address.rpt & 30252_Address_Barcode.rpt

Label Type: Dymo label printer with 30252 Address labels
**30252_Address_Recut.rpt**

Label Type: Dymo label printer with 30252 Address labels

**30256_Shipping.rpt & 30256_Shipping_Barcode.rpt**

Label Type: Dymo label printer with 30256 Shipping labels
**30256_Shipping_Recut.rpt**

Label Type: Dymo label printer with 30256 Shipping labels

![Barcode Image](image1.png)

**30252_Address_Symbol.rpt & 30252_Address_Symbol_Barcode.rpt**

Label Type: Dymo label printer with 30252 Address labels

![Barcode Image](image2.png)

**30256_Shipping_Symbol.rpt & 30256_Shipping_Symbol_Barcode.rpt**

Label Type: Dymo label printer with 30256 Shipping labels

![Barcode Image](image3.png)
**Part:** Back 1  
**Cabinet:** Std Base Frameless-MOD1  
**Material:** 3/4 Generic  
**Job:** My Kitchen  
**EBanding:** Generic

- **Sheet #:** 1  
- **Part #:** 1  
- **Cabinet #:** 1

---

**1p33x4_Address_Sheet.rpt & 1p33x4_Address_SheetBarcode.rpt**

Label Type: Sheet Inkjet or Laser printer with 1.33" x 4" labels  
- Avery 5162 or 8462  
- OL100WR from www.OnlineLabels.com
Ip33x4_Address_Sheet_Recut.rpt

Label Type: Sheet Inkjet or Laser printer with 1.33" x 4" labels
- Avery 5162 or 8462
File menu

- OL100WR from www.OnlineLabels.com

2x4_Shipping_Sheet.rpt & 2x4_Shipping_Sheet_Barcode.rpt

Label Type: Sheet Inkjet or Laser printer with 2" x 4" labels
-Avery 5163 or 8463
Label Type: Sheet Inkjet or Laser printer with 2" x 4" labels
- Avery 5163 or 8463
- OL125WR from www.OnlineLabels.com
The Export option will create a file containing all the current setting in Control Nesting. This helps Thermwood debug any cases that are causing problems. To create an export click on the File menu and select the Export option. Then send this file to Thermwood with a description of your problem.

Save/Load Settings/Tooling
These options allow for Saving and Loading Settings and Tooling. All grouping and tooling is saved in one file with the extension "cst".

Database Directories
The menu item Database Directories will open the dialog below. This is an area you can specify where you would like to hold the databases for OffFall, History (for recuts), and Material. This allows the use of the data from multiple machines. Caution must be observed to avoid editing the same data from multiple machines simultaneously.

Of the 3 databases, only the OffFalls.mdb file must be present for Control Nesting to function. If the file is not present then this dialog is presented when starting Control Nesting to provide a means for the user to correct the missing file issue. If Materials.mdb or History.mdb is missing, Control Nesting will automatically generate a new file for use.

![Set Correct Database Directories dialog](image)
View menu

Screen Properties
Edit -> Screen Properties opens a dialog where you can specify what colors you wish items to be displayed.

All colors are represented by their RGB (Red, Green, Blue) values.

Manual Nest Toolbar
Select this to display or disable the Manual Nest Toolbar. See Manual Nesting for help.
The Settings option must be addressed prior to running the Control Nesting software, in order for the nesting feature to operate correctly. When selecting the Settings button at the main Control Nesting screen, the following dialogue box will appear:

**Settings Grouping**
Settings can be grouped so that either an entire job or each material use a certain set of settings. The groups are relative to the tooling groups.

In order to have a job use a particular group the group name must be part of the file name that is loaded into Control Nesting.

**xxx(Group #).xxx**

The "(Group #)" text must precede the decimal point. The # represents the number of the group to be used.

For example: If the twd named MyCabinets(Group 3).twd is loaded. Group 3 settings and tooling would be used for that job.

Settings groups obey the material designations from the Tooling area if a group is not designated by file name.

If neither the material or file name designate a group then the default values are used.

If "Ignore Settings Grouping" is checked then the default settings will always be used. This does not affect the Tooling grouping.

The Copy Settings and Paste Settings can be used to transfer settings from one group to another. This Copy/Paste does not affect the Tooling grouping values.

In order to see what material names are designated for a group the "View Materials" button brings up a read only dialog displaying the materials designated for that group. This dialog can remain open while you change setting values or select different groups.
Quick Cut Options

Quick Cut is eCabinet Systems directly integrated with Control Nesting. To have Quick Cut you must have eCabinet Systems version 6.0 or newer installed on the Thermwood Controller. You also need to have THM version 7.4.0 or newer installed.
Quick Cut options provide control over how Control Nesting responds to Quick Cut. Quick Cut has the ability to load directly into Control Nesting and automatically Nest the parts. The following options can be enabled or disabled.

**Automatically Run Write CNC after Nesting**
- this will cause Control Nesting to instantly Write CNC after the Quick Cut job is Nested.

**Display Material Dialog Before Nesting**
- this will cause the Material dialog to be present after the job is loaded from Quick Cut. This allows for material sizes to be altered as well as merging materials with the same thickness

**Print Sheets prior to Write CNC**
- this will cause Control Nesting to automatically print the nested sheets as Write CNC is started

**Print Labels prior to Write CNC**
- this will cause Control Neting to automatically print the labels as Write CNC is started. You must designate the label printer in the provided drop down box.

**Print Instructions prior to Write CNC**
- this will cause Control Neting to automatically print the any instructional documents that have been installed for a particular cabinet or assembly

**Automatically Run Off-Fall**

- this feature will tell Control Nesting to perform a "Rolling Nest". Once this is enabled the Off-Fall that is generated on the last sheet of the previous Nest will automatically be loaded and used for Nesting. The Off-Fall must remain in it's previous location. DO NOT MOVE IT. If you do not wish to use the previous off-fall then it can be deleted in the Add Sheet area.

**Apply these settings to Non-Quick Cut Jobs**

- if you wish to use these options for jobs not loaded from Quick Cut then this can be accomplished by selecting this option.

**Dimension Format**

The section named “Format” is the dimensional mode in which the CNC code will be written when the operator chooses too write the CNC code. The Format can be set to any of the dimensional modes when nesting TWD files. However, when nesting DXF files the format must be set to the same dimension in which the drawing file was created.

```
<table>
<thead>
<tr>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feet, Inches, and Decimal 18' 6.37</td>
</tr>
<tr>
<td>Feet, Inches, and Fractions 18' 6 3</td>
</tr>
<tr>
<td>Inches and Decimal 222.375&quot;</td>
</tr>
<tr>
<td>Inches and Fractions 222 3/8&quot;</td>
</tr>
<tr>
<td>Metric 8.75mm</td>
</tr>
</tbody>
</table>
```

**Table Parameters**

The section named “Table Parameters” defines the size of the machine table, ability to swap X with Y, and the thickness of wasteboard being used. If a wasteboard is not being used, then this value should be set to zero.
The "Length Axis" value setting is used to set which axis on the machine is longer. Most cabinet machines have X as the long axis. Some Model 67 configurations have the Y axis as the longer axis so this value should be set to Y for those configurations.

**NOTE:** The wasteboard value is only present on older machines. Newer Thermwood controls handle the wasteboard value outside of Control Nesting.

### Machine Settings

**Machine Settings**

The section named “Machine Settings” is used to activate the different options that the CNC machine being operated may have.
“Sheet Selection” enables the operator to select a specific sheet that they want to start machining on, when starting a particular CNC program.

**Roller Hold Down**

The “Roller Hold Down” option is used for machines containing the roller hold down option.

**Minimize Indexing Along X**

Control Nesting will perform perimeter cuts starting with the parts closest to the home position and move along X to the final part. This minimizes indexing from part to part.

**Longest Part Orientation Along Table X Axis:**

Control Nesting will nest parts so that they are positioned long ways crossing the rollers. This will provide better hold down of the parts by the rollers.

**Use Automatic Rollers**

Some Thermwood machines have the option for rollers to automatically raise and lower based on where the sheet starts and ends along the X axis. This option can be enabled here. Control Nesting will make the appropriate calls to enable/disable the auto roller option with the appropriate sheet size. The default values are normally within acceptable tolerances. They can altered if desired. If the machine needs to leave the sheet area for a tool change then the option "Raise Rollers During Tool Change" should be checked on. If the machine has an at-the-head tool changer then this option is not necessary.
The "Bar Style Changer" option is used in conjunction with the "Aggregate Time Check" option when calculating whether or not it will be more efficient to drill holes with the router or use the 9-spindle drill bank. If your machine doesn't have the 9-spindle drill bank, neither the "Bar Style Changer" or the "Aggregate Time Check" options should be checked. If these two options are checked, the software will consider the amount of holes to be drilled and compare the time it could machine the holes with the 9-spindle drill bank versus executing a tool change and picking up a 5mm tool from the Bar Style changer to machine the holes, using the faster of the two options.

**Dual Head**
When selected, the “Dual Head” option initiates Control Nesting to write the code needed to tie the Z and W heads on a dual headed machine.

**Router Off Every Sheet**

“Router Off Every Sheet” insures that the router will be shut off after completing cut operations on each sheet of material.

**Ck Waste Board Every Sheet**

“Ck Waste Board Every Sheet” prompts the operator to check wasteboard thickness every time a new sheet is started.

**Ask To Clear Table**

When the "Ask To Clear Table" option is checked the operator will be prompted to clear the table after a sheet is cut.

Unchecking this option will eliminate the prompt. This can save the operator time spent in pressing the start button to close the prompt. If there is another sheet to be cut the operator will only be prompted to load the new sheet.

**Aggregate Time Ck**

If “Aggregate Time Ck” is selected, Control Nesting will decide whether to use single drill or a 3 spindle, aggregate drill for drilling operations.

**Table Options**

The table options drop down box allows for use of 1 or 2 tables on dual table machines. The job can be ran on either Table 1, Table 2, or Dual Table. When Dual Table is selected the job will alternate each sheet where the first sheet is on Table 1.

Single table machines should always set this to Table 1.

**Fixture & Park Locations**

This dialog allows the operator to choose the fixture offset which is in the same location as the fixed fence on the table of the machine. The fixed fence is used to locate sheet goods for primary machining operations. The operator also has the capability to select axis shift if needed. Axis Shift moves the zero location fixture offset to the corner of the sheet, closest to the HOME position of the machine.
If the "Use Fixture Offsets" is checked then the appropriate fixture offset can be entered for use. For example if your sheets will be located at fixture offset 5 you would enter G52L5. The X and Y shifts are referred to as "Adjust" when using fixture offsets.

"Table 2" settings are for dual table machines. These settings are based on the configuration of the machine. When a dual table machine has an additional axis the axis number and letter must be designated in this dialog.

"Flip Operations" settings are for single part flips or full sheet flips when the option is enabled. The flip fence can be on either table. This is why the axis number and letter options are available. Full sheet flips are not allowed to use the flip fence when in dual table mode.

“Park” allows the operator to designate where the machine head will sit when a sheet is finished being cut. This is only used for Dual Table machines.
Macros (or any text) can be inserted before and/or after each tool change. This allows a user to handle any custom calls they need prior to or after the change occurs. Multiple lines are supported.

![Tool Change Pre/Post Macros](image)

**Sheet Macros**

Macros can be inserted before and after each sheet run. This allows for any unique load/unload operations to be inserted at the appropriate points in the CNC program. The feature is merely inserting whatever text, which is put in the edit boxes on the dialog displayed below, into the CNC program. Multiple lines are possible for both Header and Footer.

![Sheet Header & Footer Macros](image)
Drill Bank Boundary

The “Drill Bank Boundary” button allows the user to define perimeters used to describe the areas of the table in which the drill bank can physically reach in reference to the fixture offset location (G901, M901, etc…). The following dialog will appear when clicking on the Drill Bank Boundary button. If a drill bank does not exist then the Ignore Boundaries option can be check. This allows Control Nesting to avoid doing unnecessary checking for boundaries. The drop down menu will allow you to set the boundaries for the Sheet Fence (see below), the Flip Op Fence or the Dual Table fence if applicable. These values are how far the machine can travel from the fence location. In this example the G901 Location is set up as the OPPOSITE corner of the sheet from the home location of the machine which means the Xshift and Yshift are checked in the Settings dialog. If your fence location is the corner of the sheet CLOSEST to home then these values would be positive instead of negative.

Placement Pins Setup

“Placement Pins Setup” allows the operator to choose settings (which pins to use and I/O’s that operate) for use of automatic popup pins. The operator has the ability with the dialog below to control which output is used to turn the pins on/off as well as which input
must be met forcing the pins to “wait”. The pins can be used for Sheet Operations, Dual Table applications and Flip Operations if required by checking the appropriate boxes.

![Placement Pins Setup](image)

**Auto Vacuum Setup**

This will enable the switch for table vacuum to be on when cutting and off when loading/unloading. Enter the appropriate cnc code to enable/disable the output(s) for the vacuum switch(s) and check Use Auto Vacuum to enable. This feature is only useful if the machine is equipped with an auto vacuum switch.

![Auto Vacuum Setup](image)

**Air Assist Setup**

The “Air Assist Setup” button contains settings that will have Control Nesting write the needed code to operate an automatic air assistance setup. The dialog below will allow the operator to choose to use Air Assist for either loading or unloading or both and which
output number controls this function. Table 2 settings are only applicable on dual table machines.

**Load & Unload**

Control Nesting will write logic to operate the Auto Load and/or Unload equipment for the specified number of sheets. Select the button "Load & Unload" to open a dialog to specify whether or not to use these features.

To implement the Load feature, insert the quantity of sheet to be loaded for each sheet nested. In most cases this will be 1, but some applications require cutting more than 1 sheet of material per nested sheet. If this value is 0 then the Load feature is not used.

The Load & Unload dialog allows for setting which type of machine will require load and/or unload commands.

The Auto Processor machines have loading and unloading options on by default so the only choice for these machines is whether or not to have a prompt from the machine when the rake is ready to unload.
When using any other machine choose the Other option. To implement the Unload feature, check the box marked "Use Unload". This will activate the rake to unload the material after each nested sheet is complete. If you are cutting more than 1 sheet at a time (sheets are stacked) you can enter the quantity to load in the edit box.

Load and Unload Pre/Post Macros provides the ability to have code inserting into the cnc propram prior to and after a load or unload call. The top entry boxes are the pre (before) options and the bottom entry box is the post (after) option. Any text in these boxes will be written as entered.

**Pocket Settings**

**Pocket Settings**

The “Pocket Settings” enable the operator to setup parameters for cutting pockets. The operator has the option to choose a “Spiral” or “Zigzag” cutting method when cutting pockets. The settings will be applied to all pockets in the nest.

**Heavy Cut**

The Heavy Cut option for spiral pocketing enables more precise pocketing to eliminate leftover from sharp corners and inner most loops missed due to large step over. Many times the Heavy Cut option can save time by allowing a large step over and adding a few additional motions to clean up the left over. This option can also increase time to complete the pocket. It is useful for complex pocket boundaries as well as large step over
values, however, in most cases a pocket can be cleanly performed without Heavy Cut by choosing a smaller or more appropriate step over.

Pocket Clean Up

The “Clean Up Amount” is the amount of material that is left around the outer perimeter of the pocket, for a finish pass. The tool that will be used for this pass can be the last tool to run the pocket, the smallest tool that is set for a pocket operation in tooling, or the largest tool that is set for a pocket operation in tooling. This setting is available in the area marked "Tool to Use” in the Cleanup area of Pocket Settings.

Minimum Pocket/Leftover Area

This is the area amount that Control Nesting will ignore for pocketing. Any pocket area that is less than or equal to this amount will not be pocketed. Any leftover area that is created in a pocket and is less than or equal to this amount will be ignored.

This value can be used to control how much material is left on inside corners. The picture below shows a typical leftover that would remain on an inside 90 degree corner.
The following is a list of common tool diameters and the approximate leftover amounts that would remain in a 90 degree corner. This table may help in determining the best value to put into the **Minimum Pocket/Leftover Area** field.

<table>
<thead>
<tr>
<th>Tool Diameter</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>.75”</td>
<td>.0303”^2</td>
</tr>
<tr>
<td>.5”</td>
<td>.0135”^2</td>
</tr>
<tr>
<td>.375”</td>
<td>.008”^2</td>
</tr>
<tr>
<td>.25”</td>
<td>.0034”^2</td>
</tr>
<tr>
<td>.1969” (5mm)</td>
<td>.0022”^2</td>
</tr>
<tr>
<td>.125”</td>
<td>.0009”^2</td>
</tr>
</tbody>
</table>

**Pocket Area (Through Cuts)**

“Pocket Area (Through Cuts)” enables the user to control the tool deciding whether to leave a plug or too completely remove all material in the center of a pocket boundary. If the through pocket has an area less than the area specified, the tool will cut away all material within the pocket’s boundary. All through pockets, with an area larger than the specified amount, will be cut leaving a plug.

**Run Pockets made of 1 arc and 1 line as a drill when the line is on the edge of the part**
“Run Pockets made of 1 arc and 1 line as a drill when the line is on the edge of the part,” is used to cut KD fastener pockets as a drill operation, rather than using the pocketing method.

**Cap DXF Pockets**

Control Nesting has the ability to insure that a pocket boundary is held to the part perimeter. This insures that the machine does not cut where the part does not exist. This may not be desired for DXF part design. For this reason the check box is available to disable this feature on DXF parts.

When a pocket boundary is 'capped' to the perimeter of a part, Control Nesting will perform the overhang calculations to run the tool past the edge. If this is not checked then Control Nesting will obey the boundary defined in the DXF and NOT perform overhang calculations.

**Cut Parameters**

**Cut Parameters**

The “Cut Parameters” section allows the operator to control the cutting methods used when machining parts.
**Cut Direction**

There are 4 options for determining direction of cut around a part.

- Climb
- Conventional
- Climb with Outline Non-Final Pass Conventional
- Conventional with Outline Non-Final Pass Climb

Non-Final Pass operations can occur when the perimeter cut is done in multiple passes. This can be from a max penetration setting or a double pass setting. The object of these options is to eliminate the occurrence of a non-uniform edge on the part. This can occur due to tool deflection.

**Recut**

The Recut feature allows the user to print labels for each part that contain a barcode for recutting the part. The parts are stored in a history database. This database is flushed of jobs that go beyond the days entered in Keep Recut History.
The barcode appears at the bottom of the label when a Crystal Report file that contains "recut" in the file name is selected. See Printing for a description of the label reports provided.

To load the part for recut you can either scan the barcode or enter the number in the Load Screen. Scanning from the Main screen of Control Nesting is also allowed. You can also scan the barcode from THM main screen if the version of THM is 7.4.7 or higher.

When a part is loaded in the Load screen it will be under the job name it originally came from with a ® in front of the name and a date and time stamp.

The "Clean" button is for clearing all recut parts in history. This actually does a file delete of all the history databases. If you are experiencing recut problems, using this option make repair the issue. Be aware that all recut data is gone when this is performed.

**Cut Through Depth**

The “Cut Through Depth” simply cuts through the part by the specified amount.

**Retract Height**

“Retract Height” is the distance the machine retracts above the part before indexing to the next part.
% Full Feed for Through Cuts

The “% Full Feed for Through Cuts” field adjusts the feed rate set for the Outline tool. Example: If the outline tool is set to run at 500 IPM, and the “% Full Feed for Through Cuts” field is set to 50%, Control Nesting will run the outline tool at 250 IPM.

Last Line Feed Speed

The “Last Line Feed Speed” is used to control the rate of speed at which the machine performs the cleanup cut for the “Ramp In Length” of the part. This is used to prevent part movement when cutting the part free from the sheet.

Min Feed Rate

“Min Feed Rate” specifies the slowest feed rate at which the machine will cut.

Max Feed Size

The value entered in the “Max Feed Size” field is set to square inches. If a part has an area less than the “Max Feed Size”, then Control Nesting will adjust the feed rate for this part only. This will also help prevent part movement for the small parts that qualify.

Ramp In Settings

Pre-Ramp Depths (Dado/Rout & Outline)

“Dado/Rout Pre-Ramp Depth” and “Outline Pre-Ramp Depth” allow the machine to plunge into the material by the specified amount, before continuing with the ramp in. This is useful when machining laminated sheets with an up spiral or compression cutter. It helps prevent chipping of the laminate.

A rout is a tool path resulting from either a pocket or centerline operation.

Ramp In Length (Dado/Rout & Outline)

Control Nesting ramps into a part rather than plunging directly into it. The benefits of this include, no burning of the material, longer cutter life, and longer spindle life. The length of this ramp is set within the “Ramp In Length”. If we set this value to 6 inches, then it will take 6” to ramp to the proper depth of cut.
The purpose for having a separate setting for Dado/Rout operations is for cases like barb dado where a minimum ramp in amount is desired to avoid disrupting the barbs in the dado.

**Outline Order**

The “Outline Order” button gives the operator the option to choose what order he or she would like the parts too cut.

**Double Pass**

Control Nesting will perform a double pass on the outline operation of small parts. The size of this small part can be set in the Double Pass dialog. This dialog is accessed by clicking the Double Pass button.

The Double Pass dialog allows the operator to set a maximum square inch or millimeter setting as well as a maximum width/length value for skinny parts. Any part that falls below either setting will get a Double Pass operation on the outline. The outline tool will cut down to the Skin Thickness on the first pass.
If you wish to have parts not get the skin removed, the "Size to Leave Skin on Double Pass Part" is provided. Any part that falls below either the Size or Width/Length setting will have the skin left on.

Double Pass

Skin Thickness
0.03"

Size to Create Double Pass
Maximum Part Size (area)
250″²
Maximum Part Width or Length
5″

Size to Leave Skin on Double Pass Part
Maximum Part Size (area)
150″²
Maximum Part Width or Length
3″

Flip Ops First

The Flip Ops First option offers the ability to cut all back side operations (flip ops) on the sheet before cutting the parts. The sheet is loaded with the back side up. The machine will cut all back side operations, including a 'sheet trim' pass if selected, then prompt for the sheet to be flipped. The flip direction required is along the width of the material. Then the rest of the operations are performed.

The "Do not allow flip parts on Added Sheets or Off-Fall" option stops parts with flip operations from being nested on Added Sheets or Off-Fall the Flip Ops First option is used. This is offered due to the fact that most times extra sheets have non-rectangular shapes which are impossible to place to the fence when after flipping.

The "Use Flip Operation Fixture when Flipping Sheet" offers the ability to have the back sided operations cut using the normal Sheet Operations fence. Then when the sheet is
flipped the Flip Operations fence will be used. This is available for machines with weak primary fixture posts.

If the Trim Sheet option is selected there are 3 options for trimming to insure the sheet is square. The amount to trim is applied to the material based on the size that was entered for the sheet. The edge of the sheet to be trimmed is the edge that is going to be put against the pins when the sheet is flipped. The amount to be trimmed can be 0" to a value
that does not result in cutting into the nested parts. If a value entered is too large a warning will be displayed with Nesting is performed.

2 Edges trimming will run the length and width of the sheet. A lead in amount can be set to insure the long edge of the sheet is fully trimmed.

3 Edges trimming will run the same 2 edges as the 2 Edges trimming but also cut the 3rd edge. This is useful for a sheet of material that is much larger than the material size that is input.

Pin Area Only trimming will trim only the areas designated for the pins. You must insure the distance to the pins from the fence are input in this dialog as well as a proper Machining Width for pin clearance. Pin 1 is the pin closest to the fence then Pin 2 is the next closest and Pin 3 is the furthest from the fence. Not all machines have 6 pins. This is why you must insure that the values are set properly for your configuration. These values must also be set for Table 2 in order to work properly for a dual table machine.

Activate Timer

Turning the “Activate Timer” on allows the user to keep track of how long it took to machine a particular job. Flip operations will not use the timer. Once all sheets have been machined, a dialog box will appear stating showing the time it took.

Do Drills First

By checking the “Do Drills First” check box, all of the drill operations in the program will be executed first.

Do Profiling Last

When this option is selected any profiling via eCabinet Systems Part Editor or MDF Doors will be performed after the outline operations have completed on a sheet.

Single Pass Tenon Cuts

This option allows Control Nesting to perform the tenon cut with 1 pass rather than a dado type operation. The pass will perform an arc ramp in and run the length of the tenon when a tool is available to accomplish the cut in 1 pass. A size check on the available tools is also performed to prevent cutting into adjacent parts in the nest.

Cut Filter

"Cut Filter" settings allow the option for Write CNC to only create code for the specified option. All operations will still display on the nest screen. The normal mode is Cut All.
No Outline Cuts

When this check box is selected the CNC code generated will not cut the outline pass on all parts in the nest.

Off-Fall

There are 3 options for Off-Fall.

Cut Full Perimeter - Each Off-Fall calculated will be cut out at the end of the sheet operations.

Save Only - Each Off-Fall calculated will be saved but will not be cut at the end of the sheet operations. This means that the Off-Fall could have 'fingers' that will not get parts Nested when used.

None - No Off-Fall calculations are performed and Off-Fall will not be saved.

Tabbing Parts

Tabbing Parts

When parts are too small to hold down with vacuum, the operator has the choice to use Tabs around the part. Tabs simply connect parts together to prevent movement.

Control Nesting analyzes the perimeter of a part as well as the parts that are nearby. This is to insure that when an adjacent part is cut the tabs will not be cut. The display will show these resulting adjacent part tabs in a different color. Below is an example of a nest where the tabs are in blue and the adjacent tabs are orange.
Control Nesting analyzes the perimeter of parts for tabbing with a set of parameters. To set the tabbing parameters click the Tabs button in Settings.

**Tab Parameters**
The “Tab” dialog defines the width of the tabs, the maximum width of the part to use tabs, and the maximum length of the part to use tabs. If we set the “Part Width for Tabbing” to 5 inches, then any part that has a width smaller than 5” will be tabbed. Note that the tabbing option is typically used for Model 53 machines. The following are other parameters that can be set to give Control Nesting an idea of how best to tab the parts for your job.

**Tab Length**: This will be the size for each tab that is applied to the part. The size is determined by the amount of distance along the perimeter of the part where the tab is created.

**Tab Thickness**: This will be the thickness of the resulting tab. Thickness is measured from the table top in the upward Z direction.
**Arc Motion:** This check box enables the cutting to be performed in a tangential arc motion. This results in a more smooth machine motion which can help avoid burn marks in the material. The shape of the tab is an arch rather than a rectangle.

**Distance in From Ends:** This parameter tells Control Nest how far in from the ends of the part to begin placing tabs. Control Nesting will try to place a minimum of 4 tabs on a part. The image below shows how this amount is measured (red). The resulting tabs are displayed in blue.

**Max Distance Between:** This parameter will help Control Nesting determine whether or not to add more tabs between the ends of the part based on a maximum distance from the 4 tabs. This distance is where Control Nesting begins to locate additional tabs. The resulting location will not always be equal to the maximum distance. The value is depicted in red below.

**Locate Increment:** This value tell Control Nesting the step amount to walk along the perimeter of the part until a good location for a tab is found.

**Proximity Allowed:** The is the closest distance allowed between tabs. If the location on the perimeter is found to be suitable for tab placement but another tab exists within this location by this amount of distance then the new tab will not be created.
**Max Deviation Allowed:** When a spot is analyzed for tab placement the perimeter is checked based on it's deviation to avoid putting tabs in a notch or on a corner. The deviation value is in degrees. For example, a corner would create a 90° deviation. This deviation check is also perform for the location on an adjacent part if an adjacent tab is required for this location.

**Buffer for Deviation Check:** The amount of the perimeter that is analyzed for tab location is greater than the tab width by this amount. This is to avoid putting a tab too close to a notch, corner, or any other undesired location.

**Nesting Parameters**

The button named “Nesting Parameters” opens a dialog which allows the user to determine size of off-fall, maximum size of scrap, additional part clearance, nest direction, collar, step angle, nest to edge, and starting corner. It also includes the option for Off-Falls to be rectangular, only nesting on Added Sheets or Off-Fall if they exist, and keeping parts with flip operations together on sheets.

The Nesting Parameters dialog can be accessed from the Settings dialog or the Edit menu. The values respect and groups that are established.
Min. Square for Off Fall

The “Min. Square for Off Fall” field determines the area in which Control Nesting searches for off-fall (Scrap material that can be used). For instance, if the operator has a value of 12 inches set, Control Nesting will search every 12 inches square for off-fall. The smallest off-fall in this case, will be 12 inches square. Control Nesting will store the dimensions for the off-fall in a database, which may be found under the “Add Sheet(s)” button from the main menu. If the user does not wish to use off-fall, setting this value larger than the maximum sheet area will prevent Control Nesting from using it.

Max Scrap Size

Maximum Width and Length for scrap will cause Control Nesting to create rout operations for cutting up the scrap into sizes that fit this criteria. The cuts will be performed after the part outlines are complete. If you do not wish to use this feature you can set the value to larger than your sheet size. The default value is 1000” for each to keep the feature disabled by default.
Add Part Clearance

The “Add Part Clearance” option is the value that increases the distance between parts. This is mainly used to prevent accidental gouging once a part has been machined, in case it moves during other operations. Part movement may be caused by insufficient hold down methods, parts being too small, etc.

Collar

“Collar” is the distance around the outside edge of the sheet stock that parts are to be nested within. Normally, an additional amount is added when the outside edges of the sheet are damaged.

Starting Corner

One of 4 corners can be designated as the starting point for parts to be nested on a sheet. This is NOT related to where your fixture is located. The starting corner represents the corner of the sheet that parts are placed as the nesting calculations are performed.

The Starting Corner can be designated for New Sheets. It can also be designated for Added Sheets & Off-Fall. The designation for Added Sheets and Off-Fall is the same.

Keep Off-Fall Rectangular
The check box for Keep Off-Fall Rectangular will cause Control Nesting to calculate Off-Fall as rectangular pieces that obey the Minimum Square value specified. This feature is disabled by default.

**Only Use Added/Off-Fall Sheets**

This option prevents Control Nesting from nesting parts on any new sheets if there are currently Added or Off-Fall Sheets loaded in the Add Sheets -> Sheet(s) Input area.

If there are not any Added or Off-Fall Sheets loaded then Control Nesting will ignore this setting and nest all parts on new sheets.

If there are Added or Off-Fall Sheets loaded then Control Nesting will only nest on those sheets and if any parts fail to fit a warning message will appear with the failed parts lists.

**Try To Keep Parts with Flip Operations Together in Nest**

This feature will tell Control Nesting to do it's best to keep all parts that have operations on the back side together in the Nest. This is very useful when using the flip ops first method to avoid the need to flip too many sheets.

Control Nesting will do it's best to keep the flip parts together while maintaining good yield. Keep in mind that this option can result in more sheets required for the job.

**Hand Select Sheet Option**

When checked Control Nesting will warn the operator to pay attention to sheet selection during sheet loading if a part with a name containing a ~ is present OR grouped parts are present. It will also stop the nesting of these parts on Off-Fall or Added Sheets. These parts can only be nested on fresh sheets when this option is checked.

**Part Rotation Step Angle**

“Part Rotation Step Angle” is a feature added to the Settings dialog to give the operator the ability to control the increments in which each part is rotated and tried when the nest is created. Example: If the step angle provided is 90 degrees, then the parts will be tried in 0, 90, 180, and 270 degrees. This value is what is used for non-grain material nests to rotate parts for optimal nesting.

**Nest to the Edge of the Sheet**

The “Nest to the Edge of the Sheet” check box will allow the operator to nest parts directly along the edge of the sheet of material. By default Control Nesting will leave the radius of the outline tool around the edge of the sheet when creating a nest and then any Collar amount will be added to that number. If the collar is set to zero and the Nest to the
Edge of the Sheet is checked, parts will be nested to the edge of the material when creating the CNC code.

**CNC File Path**

**CNC File Path**

Where the CNC file is written can be designated in CNC File Path Settings by clicking the CNC File Path button.

**CNC File Path Settings**

With the CNC File Path Settings you can designate the default directory you wish to have the CNC File written. When the option "Enable CNC Quick Write" is selected the file will be named by the last job loaded and placed in the default directory. If this option is not selected you will be asked where to save the file upon clicking Write CNC on the main screen. The File Save Dialog will open up to the default directory. The option "Write as CNC Database" is available for systems with THM 8.3.0. When this output type is used the label information is available for printing using the Label Recovery dialog from THM.
Tooling

This is where all Control Nesting tools are defined. Each tool will need to be set up in Tool Management on the Thermwood Control Prior to setting up the Operations here.
Select Tool Tolerance

This value will tell Control Nesting what tolerance to use when selecting the proper tool for an operation. The tolerance value is applied to the diameter of the tool. For example, if an operation calls for a tool with a diameter of 0.25” and the tool at the control that will work for this operation is actually 0.245 a tolerance of 0.006” will allow this tool to be selected for the operation.
Tooling Group

The purpose of tooling groups is to allow a group of tools to be used for specific materials. Currently, Rolling Nest allows 50 different tooling groups to be defined. To set up a tooling group, the operator must first define which group by using the pull-down menu. Once this has been selected, the operator must set the materials that they wish to use for this tool group.

An entire Group setting can be erased by clicking the Erase button next to the Group name.

Copy/Paste

Copy and Paste options are available. To Copy/Paste a group setting select the desired group in the drop down. Then click the Copy button or use the hot key Ctrl-C. Then select the group you wish to Paste the settings into. Once that group is selected click the Paste button or use the hot key Ctrl-V.

Group Materials

The materials that each tool group is used on is specified in the “Group Materials” section. Notice the “Add” and “Delete” buttons. By pressing the “Add” button, a dialog box will appear in which the operator may add materials from the database or create their own. After doing this, the material name(s) will appear in the white window. To delete a material, highlight the name and press the “Delete” button.

Ignore Groups

If the operator does not wish to use tooling groups, Rolling Nest will use the tools specified under the Default group, once the “Ignore Groups” box has been checked. Now we must select the tooling to use for a tooling group, or the default group. Control Nesting only allows tools that are correctly set up in the 91000 Super Control’s Tool Table. The tool table can be accessed by exiting Control Nesting and pressing the F9 (Tool Management), then F2 (Tool Table) keys on the keyboard.

Outline Tool Setup

The first tool is defined in the “Outline Tool Setup” section. This section defines the tool to be used for all perimeter (outline) cuts. By pressing the “Select Outline Tool” button, a
dialog box will appear with a list of tools that are currently setup in Thermwood’s Tool Table. To view the details of a tool, highlight it and press the “Details” button. To select the tool for use, highlight it and press OK, or just double-click the tool. Note that Control Nesting also uses the tool’s diameter to determine the distance between parts when nesting. Once the tool has been selected, the operator must set the “Feed Speed”, “Plunge Speed”, “Max Penetration”, and “Spindle Speed”. If the machine is configured for it, the operator has the option to choose the “Reverse Spindle” option.

The "Max Penetration” setting keeps a tool from being used at a depth greater than this amount in 1 pass. If a depth of cut is greater than this amount Control Nesting will perform the operation in incremental passes at the "Max Penetration” amount until the operation is complete.

### Operation Tool(s) Setup

All other tooling will be defined in the “Operation Tool(s) Setup” section. Control Nesting has the option to setup 50 different operations. To start, choose an operation number from the pull-down menu. Then select the “Select Operation Tool” button and choose a tool. Now we need to define the operation(s) that we would like to use this tool for. This can be done by selecting the appropriate operation(s) under the “Type” section. Only now can we set the “Feed Speed”, “Plunge Speed”, “Spindle Speed”, "Max Penetration”, and “Reverse Spindle”. These fields are grayed out until the operator chooses an operation type.

Tools specified as "Pocket” will be used in Pocketing operations. The pocketing feature will search through the list of Operation Tools set to "Pocket" then sort them from largest diameter to smallest diameter. On each pocket operation the tools will be used in this order until either the minimum leftover area is satisfied or the tool list is complete. “Step Percentage” is the amount the tool will step over each cut pass based on a percentage of the tool diameter.

The "Max Penetration” setting keeps a tool from being used at a depth greater than this amount in 1 pass. If a depth of cut is greater than this amount Control Nesting will
perform the operation in incremental passes at the "Max Penetration" amount until the operation is complete.

The "Drill Type" setting tells Control Nesting what type of drill a particular tool number is designed to accomplish. This is where drill bank options are established.

**X3 Y3 X5 Y5 CX3 CY3 CX5 CY5:**

A 3 and 5 drill bank is designated in THM Tool Management by setting the tool number's actuator position number to designate the CENTER drill bit. The X bank will be a separate tool number from the Y bank. This logic was put in place to handle any different number of positions. That is why the actuator position number is critical. Control Nesting understands that the actuator position is the CENTER of the bank. If your drill bank is mounted to a C axis then the C options should be selected.

![Drill Bank Diagram](image)

**Fig. 1**

*Drill Bank Example:*

If your drill bank is like Fig. 1 you would set the actuator position to 3 for the X axis tool number and 7 for the Y axis tool number in THM Tool Management. Then in the Tooling section of Control Nesting you would set the Drill Type to X5 for the Operation Tool using your X axis tool number and Y5 for the Operation Tool using your X axis tool number. If you only wish to use 3 drills then you pick the center actuator position number for the tool number in THM Tool Management and then designate that Tool Operation as X3 or Y3.

**Custom:**

The Custom option for Drill Type gives the ability to set up larger drill banks as well as bank counts other than 3 or 5. This setting allows the designation of the lead drill along
with the count of drill bits before and after. The designation is determined based on the positive (+) or negative (-) direction. In the following image a custom drill operation of 3X5 has been entered. This means that the bank is along the X axis and there are 3 bits in the negative direction from the lead bit and 6 bits in the positive direction from the lead bit. This makes a total of 10 bits. The tool number in THM Tool Management that will be selected for this operation should have an actuator position number set to the value that allows these counts to be accurate.

Notice the “Interpolate” selection. With this selected, we are allowing that tool to be used for any circle interpolation that may be needed. Also, with this selected we are now able to set the “Max Interpolate Diameter” field. The “Max Interpolate Diameter” field allows the user to limit the size of hole to machine with that tool. Normally, when drilling a hole with a high RPM, there is a risk of burning the material or damaging the tool. Interpolating a hole will prevent this from happening.

Dove Tail tool specifications can as be set with *Dove Tail Tool* and *Dove Tail Male Routs* check boxes. The *Dove Tail Tool* check box is to designate the tool is a Dove Tail Tool. The *Dove Tail Male Routs* check box is to designate this tool is to be used to cut the male ends of the dove tail joint if and only if the tool diameter is small enough to perform the radius cuts that are present in a particular joint.

*Ignore Cut Through Depth* will stop Control Nesting from adding the Cut Through Depth to an operation that is a through cut with this tool.
**Break Through** will apply the specified amount to the depth of the drill operation when the drill operation is a through cut. When enabled this value is used in place of the specified Cut Through Depth amount in Settings.

**Add Depth** will apply a positive or negative value to a drill operation for that tool when the hole to be drilled is not a through hole.

Some jobs such as MDF Doors can require special tooling. For these jobs the tool recognition is done by using Tool Names. Go to Tooling to designate these tools.

Clicking on Current Tool Names button will open a dialog specifying the tool names in the currently loaded job. If the job does not contain any tool name then this dialog will not display. These tool name can be copy/paste into the Tool Name entry box for the appropriate operation tool. Now Control Nesting will select this tool for the appropriate operation in the job.

**Non-Exclusive** will allow Control Nesting to continue to obey the Tool Name designation, however, if an operation in a job does not contain a Tool Name, the operation tool will still get selected if it meets all other specified properties.
Confirmation Screen

The “Confirmation Screen” button allows the user to review all settings that have been made in the “Tooling” section of Rolling Nest.
Drill Bank Configuration

This dialog allows you to set which drill bank installation is on your Thermwood CNC Router. This allows Control Nesting to understand which direction is positive and negative for Custom Drill Bank designations.
Pocket Screw

eCabinet Systems 6.0 Build 12 offers the option for Pocket Screw construction. A Pocket Screw operation can use 1 or 2 tools.

Pocket tool (tool name pocketscrew):

This tool must be 3/8" diameter and capable of cutting a ramp in pocket. A tool name pocketscrew designates the tool.

Position shelf and clean up tool (tool names pocketscrewdrrill or pocketscrewdrrills):

This tool must be 5mm or smaller. When the tool is designated with a tool name pocketscrewdrrill, only the position shelf drill operation will occur. If the tool is designated with a tool name pocketscrewdrrills, The shelf will be cut as well as 2 additional drill operations to clean up the radius' created by the 3/8" tool. This clean up aids in making a more flat surface when tightening the screw to avoid cracking.

Material

Clicking the Edit menu and selecting the Material option brings up the following dialog for altering the currently Loaded Materials width, thickness, and whether or not it has grain. There is also an option for merging materials that have the same thickness.
To edit the width, length, or whether or not the material has grain you can either click on the entry field or use the tab key.

**Merge**

To Merge materials you must first select the materials you wish to Merge by holding down the Ctrl key and clicking them.

Only materials with the same thickness can be merged.

Once you have the materials you wish to Merge selected, click the Merge button and the following dialog will appear to give the new Merged material a name, size, and grain designation.
Rotate Flip Operation

Sometimes parts can be nested in an orientation where locating the part at the flip operation fence is difficult or impossible. This option allows you to rotate this part by 90, 180, or 270 degrees so that a good corner of the part can be used to locate the part at the flip operation fence. After a nest is created click the Edit menu and select the Rotate Flip Ops option to bring up the following dialog. The angle can be changed for the appropriate part by either clicking the angle entry or hitting the space bar. When locating the part at the flip operation fence, flip the part as usual then apply the desired rotation to the part.
Nest Parameters
See Nesting Parameters under the Edit menu --> Settings category:
Thermwood Control Software Version Override
This dialog allow you to select which version of Thermwood Control Software is recognized by Control Nesting. The default value allows Control Nesting to view the currently installed version of Thermwood Control Software to make appropriate decisions and G & M code. If you wish to use Control Nesting for creating code to an alternative Thermwood Control Software then select the appropriate version from the drop down list provided.
**View Manipulations**

**Zoom**  
There are 2 methods for zooming.

1.) Using keyboard you can press the + key to zoom in and press the - key to zoom out.

2.) Using the mouse you can hold down the shift key and hold down the left mouse button. Then drag the mouse to create a blue rectangle to create a zoom window. When you release the mouse button the view will zoom.

**Pan**  
There are 2 methods for panning the view.

1.) Hold down the shift key and press the arrow key to pan the view in the desired direction

2.) Hold down the shift key and the right mouse button then move the mouse the desired direction.

**Resize**  
To resize the Control Nesting screen click and hold the left mouse button on the bottom right corner and drag the window to the size desired. This size will remain even after shutting down and re-staring Control Nesting.
Adding Sheets and/or Off-Fall

A dialog box resembling the following picture will appear when selecting the Add Sheet(s) button. To begin, a job must be loaded before entering any irregular shaped scrap, undersized sheet stock, or off-fall left from prior nests. Off-fall can be added by scanning the barcode at this time or selecting from the Off-fall Library. The material entered in this section may be used in future nests, as long as the material name matches the part material. Once everything is completed under the Add Sheet(s) section, the operator may select the Return button to get back to the main menu.

OffFalls/Added Sheets

To access the saved OffFalls/Added Sheets and view the material that is listed, select the “OffFalls/Saved Sheets” button. This will bring up a dialog box resembling the following picture.
Items can be selected for loading into the Sheet(s) Input dialog or deleting. Only material that is currently loaded in Control Nesting can be loaded. You can view all materials by selecting the All Material option.

To change the Name of an Added Sheet you must click on the Name then enter the new name.
**Load Selected**

The Load Selection button allows the operator to load the selected OffFalls and/or Added Sheets from the lists into the Sheet Input dialog. This will make the item(s) available for Nesting. To make multiple selections you can either hold the Ctrl key or Shift key while left clicking on the item.

**Delete**

There are 2 methods for deleting, Delete Selected and Delete All. Delete Selected will delete all the items that are currently selected in BOTH lists. Delete All will delete ALL the items in BOTH lists.

**NOTE:** Only the items in the list will be Deleted. If you have Loaded Material Only selected then all the OffFall/Added Sheets that are NOT made of currently loaded material will not be deleted.

**Search Option**

The Search Option allows the ability to enter a bar code from the label on the off-fall. Enter the number without the $ symbol then hit enter or click Go. The item will be selected in the list if it exists. Then you can load or delete that off-fall.

**Note:** Previous selections will remain when using this option.

**Sheet Entry**

The first section is called “Sheet Entry.” “Select Material” is where the operator will enter a material name, or choose from the pull-down menu. If the material name doesn’t
match the part material, then Control Nesting will not use it. If it is rectangular, check the field next to “Rectangular” and enter the dimensions for “Length” and “Width.” To the right, Control Nesting will draw the rectangular scrap. If the material is not rectangular, un-check the “Rectangular” field and enter points into the “Point X” and “Point Y” fields. This requires that the material be drawn in a point-to-point fashion. Selecting “Enter Point” will place the point in the large window. If any of the points have been entered incorrectly, “Undo” may be selected to start over. The points entered must create a closed contour.

NOTE: The sheet entry must be entered from the 0,0 reference point at the top right corner of the table.

Void Entry

The next section is called “Void Entry.” It allows the user to specify a bad section within the sheet; Control Nesting will not nest any parts into these sections. Voids can not be created until a sheet is created. The void is drawn in a point-to-point fashion or by specifying a rectangle center point, width, & height. When entering point by point, once a closed loop is created the Void is complete and the Void number increments so that you may continue to create Voids if you wish. The Undo button will remove the current point in the current Void or remove the rectangle if that was the input technique used to create the Void. If all points are undone then that Void is removed.
Adding Sheets and/or Off-Fall

Rotate

Rotate allows the operator to rotate the current data. It is done in 90° increments. The left arrow rotates counter-clockwise and the right arrow rotates clockwise.

Sheet(s) List

This list contains the Sheets created and/or OffFalls/Added Sheets loaded that will be used when nesting.

The ID/Name column will either contain the OffFall ID for OffFall entries or a Name for Added Sheets. The Name can be altered for Added Sheets by clicking the Name for an entry. It gets the value "Added" by default. OffFall ID can not be altered.

The Save Selected button will save any selection to the Added Sheet database. The saved sheets can be accessed by clicking OffFalls/Saved Sheets button.

Removed Selected will remove the selected items from the list so that they will not be considered for Nesting.

Remove All will remove all items in the list.

The Remove options will NOT delete any Saved Sheets or OffFall. It only removes them from Nesting consideration.

To Load an item in the list click on that entry. The sheet or offfall can now be altered. Then the changes can either be applied to that entry or added as a new entry. The Apply
and Add as New buttons are available on the left when an item from the list is selected for this purpose.

<table>
<thead>
<tr>
<th>ID/Name</th>
<th>Material</th>
<th>Length</th>
<th>Width</th>
<th>Thickness</th>
</tr>
</thead>
<tbody>
<tr>
<td>Added</td>
<td>3/4 Generic</td>
<td>1000mm</td>
<td>1000mm</td>
<td>18.288mm</td>
</tr>
<tr>
<td>My Sheet!</td>
<td>3/4 Generic</td>
<td>2000mm</td>
<td>800mm</td>
<td>18.288mm</td>
</tr>
<tr>
<td>-742009803</td>
<td>3/4 Generic</td>
<td>727.456...</td>
<td>568.96mm</td>
<td>19.05mm</td>
</tr>
</tbody>
</table>

Accept Sheet

Once all sections are completed, selecting the Accept Sheet button will place the material into the Sheet(s) List window. This will create a new entry in the sheet list to make it available for Nesting.

Apply & Add as New

When an item is selected from the Sheet(s) List or loaded from the OffFalls/Added Sheets dialog the following buttons appear.

The Apply button allows you to apply the current settings to the selected OffFall or Added Sheet. This is only a change for the currently loaded item. It will not change the OffFall or Added Sheet that is saved in the OffFalls/Saved Sheets dialog. The changes will affect the item for current use in Nesting. Once Control Nesting is closed the changes are gone.

The Add as New button allows the current data that is entered to create a new Added Sheet. This is similar to the Accept Sheet button.
Clear
The Clear button removes all data that is currently entered. It does NOT delete any items from the list. This button is useful for starting over if needed.

Save Selected
The Save Selected button allows you to save the item(s) in the Sheet(s) List. The saved item will appear in the Offfalls/saved Sheets dialog in the Added Sheets list. All saved sheets will remain available until deleted in the OffFalls/saved Sheets dialog. If OffFall is selected it will be saved with the default name "Added".

Remove All
The Remove All button removes all items from the list whether they are selected or not. When all items are removed they are no longer available for Nesting.

Remove Selected
To remove sheets from the Sheet(s) List window, the operator must highlight the sheet and then select the Delete Sheet button. Any material in the Sheet(s) List window will be used in the next nest, if possible. By removing a sheet from the list this stops this sheet from being used for nesting. Remember, the material name must match the part material name in order to use it.

Return
The Return button will return operator to the main Control Nesting screen if selected.
The EZ Off-Fall dialog provides a simpler interface to quickly load Off-Fall for use. With the addition to this dialog Control Nesting now holds all Added Sheet and Off-Fall loaded. If it is not used it will still be loaded ready for use the next time you start Control Nesting.

When you start EZ Off-Fall you are presented with a dialog box for entering the barcode with the keyboard or scanning.

Once you enter or scan your Off-Fall the following dialog appears.
You can now rotate the Off-Fall and Accept it to tell Control Nesting it's ready for use. Notice the LABEL image. This helps depict the orientation of the Off-Fall.

If you click Don't Use then the Off-Fall is simply not added to the queue for Nesting. If the Off-Fall was already added then it is removed.

If you click Delete then the Off-Fall is deleted and can not be scanned or entered again.
Nesting

Control Nesting is now ready to begin nesting the TWD, MDB or DXF file(s) that were loaded earlier.

There are 2 Nesting methods that can be selected. True Shape and Cut Line. The options can be set in the Action menu. True Shape method will try to fit the parts tightly to the starting corner allowing them to interlock among each other if possible. Cut Line nesting will fit the parts while trying to leave a common edge between them.

The nest will be based off of the previous inputs. Along with the nest, a yield percentage, material type, and number of sheets used will be displayed. To scroll through the sheets in the nest to view, simply click on the drop down arrow and select the sheet you want to view.

By selecting the Nest X or Y button, Control Nesting will display a layout of the nest onto the machine diagram, as shown below. Using the X button means the nest with progress along the X axis. Using the Y button means the nest will progress along the Y
axis. The following image illustrates how the nesting occurs based on the direction and starting corner. (see Starting Corner in Nesting Parameters)
Writing CNC

The “Write CNC” button is the final step for creating a nested program. When this button is selected from the main menu, Control Nesting will output the necessary code to cut parts, to the Thermwood Software screen. It will also save the file in the D:\Data\Rolling_Nest\CNC-Files directory.
DXF

DXF File Nesting Capabilities

With

Thermwood’s Control Nesting

INTRODUCTION

All major CAD and cabinet design software programs offer DXF file format output of the completed design. The DXF format offers a standard format in which to transmit information, however, it does not specify exactly what information is transmitted. Therefore, each software package communicates information in a slightly different manner, even though they may all use the specified DXF format. To further complicate matters, most software allows the user to specify some critical information, the layer names for example. To offer universal compatibility between various software packages and the Thermwood 91000 Super Control, certain conventions have been established that the user must follow. These conventions fall into two categories. First, for files from certain software packages, we must know which software the files come from in order to properly use the information included in the file. We have created a unique file extension for these instances. For example, DXF files from Cabinet Vision must use the file extension .cvDXF instead of the normal .DXF. You will need to rename the files using the proper extension before transmitting them to the Super Control. A complete listing of required file extensions is included in this tutorial. The second convention involves layer names. The DXF Translator relies on layer names to separate information for processing. The CAD system must have the ability to support layers to work with Control Nesting, however, most do since this is an integral part of the DXF format. Layers are used to separate information. Perimeter outline is placed on one layer, machine operation for the front side on another, etc. Some software hardcode the layer names so that the user cannot change them. In these instances, the file extension tells us which software created the file and we can then work with the fixed layer names. Most software, however, allows the user to specify layer names. In these cases, the user must use layer names that we recognize for us to be able to use the information properly. Once these two conventions are followed, the resulting files can be sent to the Super Control and selected along with other files and output from eCabinet Systems using the standard Control Nesting techniques. Files from multiple sources can be nested together in a single job, thus helping achieve better yields.

Defining Layer Names
Defining Layer Names

The following is a list of layer names that are recognized by Thermwood’s Control Nesting Software. Layer names are not case sensitive.

Format

Example: Name d#p# z#p#

Name – This is the Portion of the Layer name that specifies the type of operation.

d#p# - Is inserted along with layer name, designates the diameter of tool to be used for particular operation (Used for centerline and pocket layers. MUST be at the end of the layer name).

z#p# - Is inserted along with layer name, designates z cut depth for all parts and indicates part thickness when on the outline layer of 2D parts. Must be at the end of a layer name.

The Letter “p” represents the decimal point for either the diameter or depth value. (Example: centerline d0p75 z1p5) This represents a centerline layer using a tool with a diameter of .75” and machining at a depth of 1.5”.

Layer Names

outline - Indicates outline/through cut (Example: outline z#p#). Can be constructed with lines and arcs (Note: light weight polylines should work although polylines are not supported at this time. If saving DXF file from AutoCAD, select version 13, to save polylines as light weight type).

border - Is equivalent to an outline layer name.

panel - Can be set equivalent to an outline layer name via an ini file setting. Call Thermwood for information.
**pocket** - Indicates pocket cut (Example: pocket z#p# d#p#). If a tool diameter (d#p#) is not specified then the diameter set in Pocket Settings will be obeyed. All lines and arcs on this layer identify the outer boundary of a pocket.

**pocket clamp** - Indicates pocket clamp area for a pocket at the same depth. All lines and arcs on this layer identify the boundary of the clamp(s). Each desired clamp must be a closed chain. Nested clamps (clamps inside clamps) work in opposite behavior. The first clamp will prevent a tool from machining inside the clamp. A second clamp inside that clamp will cause the machining to occur inside the clamp. A third clamp inside the second clamp will cause machining on the outside of the third clamp and inside of the second clamp. If a user desires to have the clamp offset in or out based on tool diameter the key words **compin** or **compout** can be used in the layer name respectively. This is useful for clamping a hole and the user wants the machining to be performed past the edge of the clamp. For example: pocketclamp z0p375 (where the Z value matches the pocket depth of the pocket layer you wish to clamp)

**dado** - Indicates dado cut (Example: dado z#p#). This layer is constructed of (4) connecting, straight lines.

**back** - Indicates back operation for dado, chain, pocket, or drill (Example of back drill operation: backdrill z#p#). Z or depth values are defined from primary side, top of material.

**drill** - Indicates drill operation (drill z#p#). Geometry on drill layers must be constructed as complete circles. If the holes can be drilled with the drill bank Control Nesting will recognize.

**bore** - Is equal to drill layer.

**hbore** - Operation is ignored.

**centerline** - Cut indicating where the centerline of tooling will travel (Example: centerline z#p# d#p#). Layer must be constructed from lines and arcs.

**chain** - This layer has been added to give the user the ability to manually nest parts in the dxf file and control which direction the tool compensates based on the geometry. Also provides another tool to create toolpaths on interior geometry. Chain compin will compensate to the inside of the geometry and chain compout will compensate to the outside based on the tool diameter specified. (Example: chain compout z#p# d#p#).

**start** - Enables operator/programmer to specify a start point for chain type geometry that has been created within a DXF file (ie: entities saved on level/layer named: chaincompin/out or outline). To specify starting point for a particular design there are 2 options:
1: Take the one entity you wish to start on and save it to a level/layer of it's own. That level/layer name will then need to be same as type geometry that remaining entities reside on, but must also contain the character set "start" at the end (ie: outline z#p# start).

2. Create a point at the location you wish to start (it must exist on an entity being used). Point should exist in it's own level/layer. That level/layer name will then need to be same as type geometry that remaining entities reside on, but must also contain the character set "start" at the end (ie: centerline z#p# start).

**zchange** - When the word 'zchange' exists in a centerline layer Control Nesting will obey the Z values for that line. This allows the ability to cut in a ramping motion. Only lines are supported. (Example: centerline z#p#).

**tool name** - A tool can be specified for an operation by using a name. The value should be in enclosed with brackets [ ]. A tool with a matching name in Tooling will be used for the operation. (Example: centerline z#p# [toolname])

**plunge** - A centerline layer has the option to support plunging at the start rather than performing a ramp-in. The layer name must contain the word 'plunge'. It is not case specific.

**macro** - If a macro call is desired for an operation on the part, this option is available. The layer must contain a point, line, or circle. The layer name must contain a tool diameter for tool selection via the d#p# designation or a tool designation by [toolname]. The macro call desired must be in the layer name as well. The number should be preceded by the letter 'm'. Up to three number variable values (preceded with letter a, b, and/or c) can be specified in the layer name as well. Coordinates and variables are set in the CNC program based on what entities are included in the layer. (Example: macro d#p# a#p# b#p# c#p# m#)

Here is a list of the four possible entity uses and the resulting code in the CNC program.

- **point**
  
  tool call based on d#p# or [toolname] (tool operation type rout/dado)
  
  G00X#Y# (index to location of the point)
  
  [SPNTX = #] (x coordinate specified by the point)
  
  [SPNTY = #] (y coordinate specified by the point)
  
  [A_VAR = #] (number specified in layer after the letter 'a', if not designated the value will be zero)
  
  [B_VAR = #] (number specified in layer after the letter 'b', if not designated the value will be zero)
  
  [C_VAR = #] (number specified in layer after the letter 'c', if not designated the value will be zero)
  
  M# (call to macro designated in the layer name)
- **line**

  tool call based on d#p# or [toolname] (tool operation type rout/dado)
  G00X#Y# (index to location of one of the points on the line)
  [SPNTX = #] (x coordinate specified by the line end point)
  [SPNTY = #] (y coordinate specified by the line end point)
  [EPNTX = #] (x coordinate specified by the line end point)
  [EPNTY = #] (y coordinate specified by the line end point)
  [A_VAR = #] (number specified in layer after the letter 'a', if not designated the value will be zero)
  [B_VAR = #] (number specified in layer after the letter 'b', if not designated the value will be zero)
  [C_VAR = #] (number specified in layer after the letter 'c', if not designated the value will be zero)
  M# (call to macro designated in the layer name)

- **line and point** (where the point is on the line start point)

  tool call based on d#p# or [toolname] (tool operation type rout/dado)
  G00X#Y# (index to location of the point)
  [SPNTX = #] (x coordinate specified by the point)
  [SPNTY = #] (y coordinate specified by the point)
  [EPNTX = #] (x coordinate specified by the line end point)
  [EPNTY = #] (y coordinate specified by the line end point)
  [A_VAR = #] (number specified in layer after the letter 'a', if not designated the value will be zero)
  [B_VAR = #] (number specified in layer after the letter 'b', if not designated the value will be zero)
  [C_VAR = #] (number specified in layer after the letter 'c', if not designated the value will be zero)
  M# (call to macro designated in the layer name)

- **circle**

  tool call based on circle diameter or [toolname] (tool operation type drill)
  G00X#Y# (index to location of the circle center point)
  [SPNTX = #] (x coordinate specified by the circle center point)
  [SPNTY = #] (y coordinate specified by the circle center point)
  [DIAMETER = #] (diameter of the circle)
  [A_VAR = #] (number specified in layer after the letter 'a', if not designated the value will be zero)
  [B_VAR = #] (number specified in layer after the letter 'b', if not designated the value will be zero)
  [C_VAR = #] (number specified in layer after the letter 'c', if not designated the value will be zero)
  M# (call to macro designated in the layer name)
**Stipulations**

There can only be one “Outline” layer or layer that is equivalent to an outline layer, per DXF drawing. The tool used to machine the “Outline” geometry is set up in the “Tooling” section of Control Nesting. Geometry defining the “Outline” layer must be a completely closed or trimmed loop. Circles must be broken when used on any layer other than the drill layer. (Circle geometry indicates drill operation to Control Nesting). There can be no duplicate entities in DXF drawing. If there is a diameter (d#p#) specified in a layer name (used to define diameter of tool to be used), the diameter must be identical to that of the tool in the tool manager on THM control. Order of operations can be defined in a DXF file. This can be done by adding a number to the end of a layer’s designator name. The number will be used to identify the order of operations. Example: A part containing 3 different operations can be set up so that the operations are cut in a particular order:

```
“centerline1 z0p75 d0p5”
“centerline2 z0p82 d0p25”
“centerline3 z0p85 d0p125”
```

When using the Chain layer name, the number should be after the compin or compout designation. Example: “chain compin1 z0p75 d0p5”.

**Tutorial**

**DXF Tutorial**

The purpose of this tutorial is to provide the fundamentals for creating DXF files for use with Control Nesting software. The sample DXF file used in this tutorial may be downloaded from this link: [http://order.ecabinetsystems.com/updates/layers.dxf](http://order.ecabinetsystems.com/updates/layers.dxf). There is also a picture of the DXF file available in this document to help understand the setup.
Layer Definitions

Outline

The perimeter of the part is drawn on the layer named “outline z0p75” and is drawn in the color green. This layer name tells Control Nesting that it is an outline operation with a cut depth of 0.75. Since this will always be a through cut, it should be equal to the material thickness. The material thickness used when loading each dxf file in the Control Nesting Software MUST match the thickness specified in the outline layer! The depth of cut is controlled by the “z0p75” section at the end of the layer name. The “p” represents a decimal place.

Dado

The next layer to discuss is the “dado z0p3125” layer. This layer defines the upper left dado operation for the part and is red in color. As you notice, this particular dado is being machined 0.3125” deep from the top of the part.

Drill

The “drill z0p1875” layer is being used to drill the blue 0.25” diameter holes towards the bottom left of the picture. These holes will be machined 0.1875” deep from the top of the part. You may also notice there is a “drill z0p75” layer. This layer contains the 2.5” diameter circle to be cut 0.75” deep from the top of the part (through cut). Although this is drawn on a drill layer, it will be machined out by the use of our circle interpolation macros provided in your Thermwood Super Control. These macros will only be used if the hole diameter is larger than the tool diameter.

Centerline

Now we are ready for the “centerline d0p375 z0p75” layer. Up until now the DXF file has been drawn exactly as the part is. For this layer, we need to draw where we want the center of the tool to follow….a centerline. This layer has many possibilities and is meant to define interior cuts, however odd they may be. In the picture above, the odd yellow
shape represents the “centerline d0p375 z0p75” layer. Let’s take a closer look at this particular layer name. We already know that the word “centerline” represents the toolpath for an interior cut. We also know that “z0p75” represents a 0.75” deep cut from the top of the material. The “d0p375”, however, represents what size tool we want to use to machine the interior cut. Once again, the “p” represents a decimal place. The letter “d” represents diameter. In this case, a 0.375” diameter tool will be used to perform a 0.75” deep cut from the top of the part.

Pocket

Level number 9 contains the purple geometry in the bottom center of our example and has been created on a layer named “pocket d0p5 z0p375”. This pocket will use a tool with a diameter of .5” and machine the pocket .375” deep. If the diameter of tool to be used isn’t specified in the layer name the tool set in the Pocket settings in Control Nesting will automatically be used for the cut. The cut convention or style will be set in the settings dialog in Control Nesting. You have the ability to change from spiral, zig-zag, inside to out or outside to in, etc.

Chain

Levels 10 and 11 illustrate the use of the Chain Layer. These are “chaincompin d0p375 z0p125” which will use a .375” diameter tool to machine the cut .125” deep, and “chaincompout d0p25 z0p125” which will use a .25”diameter tool to machine .125” deep. Chaincompin will compensate to the inside of the geometry and chaincompout will compensate to the outside of the geometry. These layer names will give the operator the ability to create manual nests in the dxf file or serve as an additional tool for performing interior cuts.

NOTE: The diameter of tool must be specified when using either of the chain layer names.

Order of Operations

You also have the ability to specify the order of operations with the layer names by adding the number to the end of each layers designator name, and Control Nesting will use that number when setting the order of operations. Example: A part with 3 centerline operations could be done with 3 different layer names, thus setting the order that each of the three centerline operations will be performed with respect to the other centerline operations.
NOTE: You can specify the order of any of the available layer names by simply appending the number in which you want that operation to be cut. This will work with any of the available layers.

“centerline1 z0p75 d0p5”
“centerline2 z0p82 d0p25”
“centerline3 z0p85 d0p125”

Sample DXF File

Let’s begin by opening the DXF file named “layers.dxf” in a CAD/CAM software that supports the DXF file format. Take a moment to view the different layer names and what is drawn on each of them. This is the key part in making DXF files work with Control Nesting. The layer names contain information such as type of operation, depth of cut, and in some cases, the diameter of tool to be used. Below is a picture of the DXF file:

Level Manager Example:
Level Manger image of the above DXF file to illustrate the layer names, depth and tool diameter settings for each corresponding layer:
Entities may be drawn in any color. The drawing can be in metric or inches. In the Control Nesting SETTINGS option on the Thermwood controller, the FORMAT section needs to be Metric or Imperial depending on the format of the DXF drawing, this will determine the output of the CNC code. The colors being used here are for tutorial purposes only.

**Flip Operations**

Flip operations can also be used in DXF files. To do this, you will need to add the word “back” to the layer name as we did in the “backdado z0p4375” and “backdrill z0p5” layers. There is one stipulation with both these operations. The depth of cut is still entered from the same side of the material (top) to where you want the bottom of the tool to be (Thickness of material – depth of cut = z? p?). For instance, the above .dxf file is drawn for .75” thick material and the backdado operation is set at 0.4375” from the top of the part. The result will be a 0.3125” deep dado on the underside of the part. The same goes for the backdrill operation… the result will be 0.25” deep drill holes. You may also use the “back” feature with centerline, chain, and pocket layers.

There are two ways back side operations are completed.

**Flip Operations First:**
When the option for Full Sheet Flips is used the back side operations are cut for the entire sheet first. The user is prompted to flip the sheet once it is trimmed to ensure squareness.

**Post Front Side and Perimeter cutting:**

With this technique the flip operations will be appended to the end of the CNC program. The operator will be prompted to remove the wasteboard (if used) and load the first part that requires flip side machining. The part must be flipped from left to right and located in the fence location. Typically the fence location used is the G902 location but may be customized to your needs.

Unique Requirements for Software Packages

**Cabinet Vision**
File extension must be *.cvdxf so that front and back operations will be merged. If the extension is only *.dxf it will be treated as a normal DXF.

**KCDW**
File extension must be *.kcdwdx so that front and back operations will be merged. If the extension is only *.dxf it will be treated as a normal DXF.

**Microvellum**
Normally there are no specific requirements for this software. Contact Thermwood for special applications.

**Cabinet Solutions**
Normally there are no specific requirements for this software. Contact Thermwood for special applications.

**Pattern Systems**
Normally there are no specific requirements for this software. Contact Thermwood for special applications.

**CADKEY**
Normally there are no specific requirements for this software. Contact Thermwood for special applications.

**Rhino**
Normally there are no specific requirements for this software. Contact Thermwood for special applications.

**Turbo Cab**
Normally there are no specific requirements for this software. Contact Thermwood for special applications.

**MasterCam**
Normally there are no specific requirements for this software. Contact Thermwood for special applications.

**AutoCAD**
Normally there are no specific requirements for this software. Contact Thermwood for special applications.

**Intelllicad**
Normally there are no specific requirements for this software. Contact Thermwood for special applications.
VectorWorks
Normally there are no specific requirements for this software. Contact Thermwood for special applications.
Dovetail Drawer Boxes

eCabinet Systems Drawer Box Designer Setup

To properly create a drawer box for CNC machining, there are a few parameters that need to be set. Several of these setting revolve around the geometry of the female dovetail router tool that will be used.

Load a drawer box into the drawer box designer. Go to construction setting, then construction parameters of the part that will have the male dovetails. You will see the Dovetail Settings in the upper right corner of this dialog. These values (excluding inset fields) can also be changed globally on the global settings tab of the construction setting dialog.

**Placement Inset Values**: Distance from the edge of the part to the center of the first tail.

**Max. Dist. Between**: Maximum allowed distance between (center to center) before adding an additional tail.
Dovetail Depth: This value is dependant on the female dovetail tool’s geometry. *(see dimension A in illustration 1)* When using the Thermwood supplied dovetail tool *FSH1065* this value is .35”

**Fit Clearance:** This value will apply side clearance for the dovetails. This may be desired for gluing purposes. The amount entered is the sum of the total clearance (a .01” fit clearance will apply .005” of clearance on each side of the dovetail)

**Thickness (% of Material):** This value defines the thickness of the dovetails. When using the Thermwood supplied dovetail tool *FSH1065*, it will be necessary to machine down approximately .21” of material to hide the dovetail radius when parts are assembled. The Thickness % can be calculated by taking the material thickness being used minus .21” divided by material thickness being used.

\[
\text{Thickness} \% = \frac{(\text{Material Thickness} - .21”)}{\text{Material Thickness}}
\]

**Dovetail Width:** This is the dovetail width from tip to tip. Typically this value should not exceed 2 times the dovetail bit diameter *(see dimension B in illustration 1)*

**Corner Radius:** This value is dependant on the female dovetail tool’s geometry. *(see dimension R in illustration 1)* When using the Thermwood supplied dovetail tool *FSH1065* this value is .125”

**Corner Angle:** This value is dependant on the female dovetail tool’s geometry. *(see angular dimension C in illustration 1)* When using the Thermwood supplied dovetail tool *FSH1065* this value ranges 7-10 Degrees.

Set up at the Machine
Table flatness is very important to the success of a quality dovetail joint. If the machining surface is not flat, it may result in the dovetail tool’s top radiiues gouging in some areas and being too shallow in others. This may result in an unsatisfactory fit. With that said, surfacing of the spoil-board and possibly the waste board/handling sheet will most likely be required.

The tool for the female dovetail routes must be set up in the Thermwood SuperControl’s tool set up screen. The Diameter and Daylight values are the only critical values that must be set.

**Daylight:** This value is as important as the machining surface flatness. If this number is not accurate, again it may result in the dovetail tool’s top radiiues gouging or being too shallow. This may result in an unsatisfactory fit. It MUST be understood that this value can be altered for the dove tail tool to help with the fit of the joint. If the tool is not cutting deep enough the joint will show a gap. If the tool is cutting too deep the joint will be too tight. This value will need to be altered based on fluctuations in material thickness. Keep in mind that the value for depth that is set in eCabinet Systems MUST be an accurate value relative to the tool's geometry. (Please refer to eCabinet Systems Drawer Box Designer Setup)

**Diameter:** This value is taken from the tip of the tails (see dimension B in illustration 1) If this value is not defined correctly, unsatisfactory fit may result.

**Note:** Although it may be best to locate the underlying issue, this value can be used to tighten loose side to side fit by increasing the value enter.

**Control Nesting Settings Dialog**

In Control Nesting, there are 2 parameters in the settings dialog that pertain to dovetail machining. They are Dovetail Radius Crunch and Male Dovetail Feed.

**Dovetail Radius Crunch:** Due to the nature of the blind dovetail joint, there are certain crushing factors that take place when assembling the parts. When machined to the perfect dimension, the sharp corners of the male tails will crush against the radius created by the female dovetail tool causing the tails to seat potentially too deep. This phenomenon is controlled by the **Dovetail Radius Crunch** value. The value entered in this field will pull the female tool geometry back causing a shallower fit. This amount should be adjusted until desired fit is achieved. Keep in mind that different materials may require different values. (A value of 0” will have no crunch applied. The larger the value, the shallower the female cut will be. See illustration 2 for more detail)

**Male Dovetail Feedrate:** This is the federate that will be used when machining around the male dovetail joints. It is not uncommon for the same tool cutting dado operations (which typically can be cut at much higher feedrate) to be used for cutting around the male dovetail cuts.

**Material Thickness to run Outline cut around Dove Tail Tenons to minimize load on Male Dove Tail tool:** This is a value that Control Nesting will refer to when
making the decision whether or not to use the outline tool to 'hog out' the tenons to give relief to the smaller tool which will do the final cutting. If the material is thicker than this value the outline pass will cut around the tenons if and only if the diameter of the outline tool can fit between the tenons. It will leave the skin thickness value. This option will cost time in machining, but will help with thicker materials since experience has proven that the smaller tools cannot handle the full load of thicker materials for this operation.

% to reduce machine Accelerations for Dove Tail Cutting: This setting can help to make the cutting smoother around the tenons and dovetail tool cuts.

During the testing phase of the dovetail drawer boxes, it was discovered that a conventional cut direction seemed to leave a much cleaner finished edge resulting in no or minimal clean up for assembly. With that said, a conventional cut direction would be
the recommended way. Keep in mind that not all materials will react in the same way, so a climb cut should be tried if conventional does not seem to give the edge quality desired. This setting is changed on the settings dialog under cut parameters, direction.

Control Nesting Tooling Dialog

When setting up tooling for the dovetail joints, there are a few tooling settings that need to be discussed. To get to the tooling dialog, select the Tooling button on the main Control Nesting dialog. First, it is required to designate an operation tool as being the female dovetail tool. This is accomplished by the following steps:

- Select the operation # desired
- Select a tool number for that operation
- Check on the Dovetail Tool option for that operation

Next, the operation tool for the male dovetail routs may be specifically designated by checking the Use for Male Routs with Dovetail option. Having this option checked will force it to use this tool if the diameter is acceptable for the rout. If the diameter is too large, it will search the operation tools for the largest acceptable diameter that will work. If this option is not checked for any operation tools, it will automatically do a search for the largest acceptable tool diameter available.

Note: If using tooling groups, ensure that the material being used exists in the group and that the operation tools needed are specifically set for that group.
Profiling & MDF Doors/Drawer Fronts

Version Requirements:
- Control Nesting 5.0 or higher
- THM (Windows 2000) 5.05 Build 9 or higher
- THM (Windows XP) 6.1.0.3 or higher
- Profile Modeller 2.0 or higher

Until Control Nesting version 5.0, all profiling done in eCabinet Systems with the Part Editor had to be machined using the Profile Modeller. This meant that all parts needed to be done on a one by one basis. Now with Control Nesting v5.0 and up, profiled parts can be nested and cut out using the same technology available with Profile Modeller. Since it uses Profile Modeller functionality you must have Profile Modeller installed on the Controller. If the Controller do not have Profile Modeller version 2.0 or higher installed Control Nesting will not support Profiling. If you start Control Nesting and see (With Profile Modeler) stated at the top of the dialog. You have the correct
versions installed. This must be present to function.

MDF Doors and Drawer Fronts are also eCabinet System's profiled parts so they work as well. Control Nesting offers some additional features for MDF Door/Drawer Fronts. In the Settings Dialog there is a button labeled "MDF Door Tool Options". This opens a dialog to set the modelling towards the center of the region and also allows the user to designate if they have a custom tool for the interior and/or exterior region. These settings are for all MDF Door/Drawer Fronts in the nest.

The modelling aspect of the profiles will use the default tool group designated in Profile Modeller.

NOTE: A future version of Control Nesting will allow more flexibility to modify region's tool designations uniquely.
Inset Carvings

Version Requirements:
- Control Nesting 5.0 or higher
- THM (Windows 2000) 5.05 Build 9 or higher
- THM (Windows XP) 6.1.0.3 or higher
- Thermwood CNC Rental 2.0 or higher

Inset Carvings which are available through the Thermwood CNC Rental program can be applied to parts in eCabinet Systems. Control Nesting will perform these carvings as long as the Controller has the Thermwood CNC Rental application installed, the needed carving file is installed, and there are credits available to run the program.

The screen for Control Nesting will not display the carving. It will only display an arrow in the location the carving is to occur.

![Arrow designating Inset Carving](image)
Labels

Datamax-O'Neil Configuration
The Datamax-O'Neil M-4206 Mark II label printer supplied with auto labeling solutions for Thermwood can have the configuration saved as well as set from the printer's properties dialog. Thermwood default configuration file is c:\Rolling Nest\Thermwood-Datamax.cfg.

To set configuration from file:
- From the start menu select Devices and Printers
- Select Datamax-O'Neil M-4206 Mark II
- Right click and select Printer Properties to bring up the Properties dialog
- Select Tools tab
- Select Configure -> Configure Printer to bring up the Printer Configuration dialog
- Select Configure -> Read from File...
- Select a Configuration File and click Open
- Click OK

To write configuration to file:
- From the start menu select Devices and Printers
- Select Datamax-O'Neil M-4206 Mark II
- Right click and select Printer Properties to bring up the Properties dialog
- Select Tools tab
- Select Configure -> Configure Printer to bring up the Printer Configuration dialog
- Select Configure -> Save to File...
- Specify file name and click Save

Label Printer Tools
The Label Printer Tools dialog offers a means to edit label size, set label count, and move the gantry for restocking the printer. It is accessed from THM Control Options->Label Options->Label Printer Tools. It can also be accessed by calling LBLCHNG.SUB. The dialog can only be accessed from the menu if the machine has been homed.

NOTE: The move ability is only available when the setting in Control Nesting is for Auto Labeling with Machine.
The Label Counter must be reset when a new roll is added. The roll quantity must be set as well. The value is also displayed in the bottom status bar of THM. When the Current Count is equal or less than Warning Amount the value in the status bar is in red.

The Park value is where the head moves when clicking Move Machine at the feed rate specified in Park Feed. This is to allow access to the auto label printer.

Label Recovery
The Label Recovery dialog offers the ability to print labels for the currently loaded job. If a job program is not loaded in THM then the Label Recovery dialog will use the data from the last job nested in Control Nesting. It also offers a sheet print option.

The dialog is accessed in THM Control Options->Label Options->Label Recovery. It can also be opened with the OPENCN call to LABELDLG.
Auto Labeling
Thermwood offers two types of auto labeling. Both solutions use the same label grabbing hardware, however, they use two different software solutions for label
placement. Auto labeling is available with an Auto Processor with Labeling Machine or a Labeling option with a Thermwood router. To enable the feature go to the Printing dialog in Control Nesting.

**Labeling Machine with Auto Processor**

The Labeling Machine is a device constructed to label material stacked on a lift. The device also stages material after labeling for a Thermwood router to load.

The Labeling Machine runs in a separate thread which allows the Thermwood router to simultaneously operate while auto labeling is occurring. The program to be ran must be a CNC Database, or the program must be the last one generated with Control Nesting. Currently only Control Nesting jobs are supported with the Labeling Machine.

A dialog is available to operate the Labeling Machine without running the program. This dialog is explained in Label Machine and Label Machine (Interrupted)

**Labeling with Thermwood router**

Another option is to have a Thermwood router do the labeling with a printer mounted at the side of the machine. With this auto labeling solution a sheet of material is labeled prior to the cutting operations.

Labeling with a Thermwood router operates with the M160 macro. This macro requires that variables be set prior to being called. These variable are:

- **LBLX** - location of corner of label on a part in the nest on X axis
- **LBLY** - location of corner of label on a part in the nest on Y axis
- **LBLCOMMANDS** - command string for printing a label "PRINT P #" where # represents an internal part id from the CNC Database
- **LBSHT** - an integer value that informs the M160 whether or not to use the variables. If set to 1 the M160 expects a text file to contain the values necessary for what and where to label. This text file is "D:\DATA\LABELSHEET.TXT". Each line in the text file represents a part and it's label location comma delimited. For example, "6,84.2972,5.4903" means to label part with internal id of 6 at (84.2972,5.4903).

The M160 also requires machine variables to be set. They are the following:
Labels

LBLPRNTRX - X coordinate for label printer grab spot

LBLPRNTRY - Y coordinate for label printer grab spot

LBLOFFSETX - X offset required to place label center at LBLX

LBLOFFSETY - Y offset required to place label center at LBLY

LBLDELAY - delay in seconds for label device to wait prior to grabbing a label. (this value may not be required and can be zero)

The M160 has a return variable to communicate with the calling program a status.

M160STATUS - 0 for fail, 1 for success

Label Machine
The Labeling Machine dialog offers the operator buttons to manually operate the Auto Processor'sLoading and Labeling Device (Label Machine). The dialog can be accessed by clicking the label button in THM when the labeling device is NOT busy or through the THM menu Control Options -> Label Options -> Label Machine. If the labeling device IS busy the Label Machine (Interrupted) dialog will open.
NOTE: Raise Stack, Position Sheet, & Label Starting With... options will not be enabled if a labeling job is not loaded in THM.

**Go Home** - Sends the Labeling Device to the home position. If the home routine has not been ran it will perform a home routine.

**Lower Stack** - Lowers the lift table all the way down.
**Raise Stack** - Moves the Labeling Device to the center of the material. Raises the lift until the sensor on the Labeling Device sees the stack is at the proper height for labeling. If the device has not been homed, the homing routine will be ran first.

**Position Sheet** - Homes the device if the home routine has not been ran since the dialog has been started. Raises the stack if necessary. Performs the positioning routine for the top sheet on the stack. This is the position for labeling.

**Stage Sheet** - Homes the device if the home routine has not been ran since the dialog has been started. Raises the stack if necessary. Positions the sheet if necessary. Stages the sheet so that the router may load it onto the table.

**Label Starting With...** - Opens a dialog for entering which part to begin labeling. Each subsequent part will be labeled.

**Close** - Closes the dialog.

**Label Machine (Interrupted)**
The Labeling Device Interrupt dialog offers the operator buttons to interrupt the Auto Processor's Loading and Labeling Device. The dialog can be accessed by clicking the label button in THM when the labeling device is busy or through the THM menu Control Options -> Label Options -> Label Machine. The dialog will only interrupt the operation once it's task is complete and an option from the dialog is pressed. If the labeling device is not busy the **Label Machine** dialog will open which does not have the Continue option.
NOTE: All the operations occur once the Labeling Device has completed it's current task.

**Go Home** - Sends the Labeling Device to the home position. If the home routine has not been ran it will perform a home routine.

**Lower Stack** - Lowers the lift table all the way down.
**Raise Stack** - Moves the Labeling Device to the center of the material. Raises the lift until the sensor on the Labeling Device sees the stack is at the proper height for labeling. If the device has not been homed, the homing routine will be ran first.

**Position Sheet** - Homes the device if the home routine has not been ran since the device has been accessed by a program or this dialog. Raises the stack if necessary. Performs the positioning routine for the top sheet on the stack. This is the position for labeling.

**Stage Sheet** - Homes the device if the home routine has not been ran since the device has been accessed by a program or this dialog. Raises the stack if necessary. Positions the sheet if necessary. Stages the sheet so that the router may load it onto the table.

**Label Starting With...** - Opens a dialog for entering which part to begin or start over labeling. Each subsequent part will be labeled.

**Continue** - Closes the dialog and allows the Labeling Device to continue normal operation.

**Abort** - Cancels the labeling procedure for this sheet and sends the Labeling Device back to Home.
AFL

Control Nesting offers 2 calls through AFL when running Thermwood Control Software. These options provide an access point to functions developed in Control Nesting. While the majority of these functions serve Control Nesting needs, knowledge of their functions may prove to be helpful with other tasks.

OPENCN provides a call to Control Nesting where the program does NOT stop. The format is below. The string value determines the function to be performed and is described in OPENCN.

[OPENCN("")]

WAITCN provides a call to Control Nesting where the program is halted until the function returns. Return values are held in the reserved variable WAITCN_RESULT. The format is below. The string value determines the function to be performed and is described in WAITCN.

[WAITCN("")]

The following are options available using the OPENCN call.

[OPENCN("")]
- If no value is entered then the call to OPENCN will simply open Control Nesting.

[OPENCN(twd file path)]
- If a full path to a twd file is entered then Control Nesting will be started with the twd loaded.

[OPENCN("PRINT S#")]
[OPENCN("PRINT L#")]
[OPENCN("PRINT P#")]
[OPENCN("PRINT B#")]
- Print sheet prints, labels, or both for the currently loaded job. The loaded job must be a CNC Database. If the loaded job is not a CNC Database then the most recently nested job in Control Nesting will be used.
  # - Sheet number (for S,L,B) or Part number (for P) NOTE: Part number is an internal unique id for each part in the job.
  S - Print the sheet print
  L - Print the labels for a sheet
P - Print 1 part label
B - Print the sheet print and labels for the entire sheet

[OPENCN("BARCODE #")]
- Print either sheet print or labels based on # where # is a value containing a time stamp to match with the correct database for the currently loaded job. These values are imbedded in barcodes created by Control Nesting on the sheet prints if the "Print Barcodes" option is checked in Print Settings->Sheet Settings of Control Nesting.

[OPENCN("CNCDATABASE_TO_TEXT")]
- Opens a dialog to select a CNC database and extract the CNC code in that database. The CNC code is written to a file that can be specified with a dialog after the CNC database is selected.

[OPENCN("TEXT_TO_CNCDATABASE")]
- Opens a dialog to select a CNC file and store the CNC code in a CNC database. The CNC code is written to a CNC database that can be selected by a dialog after the CNC file is selected.

[OPENCN("LABELDLG")]
- Opens the Label Recovery dialog.

[OPENCN("LABELMACH")]
- Opens the Labeling Device Interrupt dialog for the Auto Processor.

[OPENCN("LABEL #")]
- Positions, labels, and stages sheet number # of the currently loaded job with the Auto Processor.

WAITCN
The following are options available using the WAITCN call.

[WAITCN("PRINT S#")]
[WAITCN("PRINT L#")]
[WAITCN("PRINT P#")]
[WAITCN("PRINT B#")]
- Print sheet prints, labels, or both for the currently loaded job. The loaded job must be a CNC Database. If the loaded job is not a CNC Database then the most recently nested job in Control Nesting will be used.
  # - Sheet number (for S,L,B) or Part number (for P) NOTE: Part number is an internal unique id for each part in the job.
  S - Print the sheet print
  L - Print the labels for a sheet
  P - Print 1 part label
  B - Print the sheet print and labels for the entire sheet
WAITCN("RUN PROMPT #")
WAITCN("RUN PROMPT #F")
WAITCN("RUN PROMPT #L")
WAITCN("RUN PROMPT #LF")
WAITCN("RUN PROMPT #AP")
WAITCN("RUN PROMPT #APL")
WAITCN("RUN PROMPT #APF")
- Opens the start dialog which contains options for sheet selection, continue to next sheet, cut, and label.
  # - Total number of sheets
  F - Job contains single part flip operations
  L - The machine is supplied with the auto label device.
  AP - The machine is an Auto Processor with a loading labeling device.

WAITCN("LABEL PRESENT")
- On machines using the labeling device this call checks the present sensor on the printer to see if a label is present. The call will wait until the signal is true.
  Return values:
  WAITCN_RESULT = 0 --> Label NOT present
  WAITCN_RESULT = 1 --> Label present
  The amount of wait time can be set. This value exists in c:\Rolling Nest\printing.ini. The numerical value # is in seconds.
[Labeler]
SocketWait = #

WAITCN("LABEL NOT PRESENT")
- On machines using the labeling device this call checks the present sensor on the printer to see if a label is not present. The call will wait until the signal is true.
  Return values:
  WAITCN_RESULT = 0 --> Label present
  WAITCN_RESULT = 1 --> Label NOT present
  The amount of wait time can be set. This value exists in c:\Rolling Nest\printing.ini. The numerical value # is in seconds.
[Labeler]
SocketWait = #

WAITCN("SHEET STAGED #")
- On an Auto Processor machines with the loading labeling device this call checks to see if the specified sheet # has been staged and is ready for loading on the machine.

WAITCN("AUTO LABEL PRINTER SETTINGS")
- Opens the Auto Label Printer dialog for label size entry, label count entry, label count reset, and label roll changing. This can also be accomplished from the THM menu Control Options.

WAITCN("PRESS ESTOP")}
- Opens a dialog waiting for the Emergency Stop button to be pressed. Once pressed the dialog provides information on how to clear the stop. Program execution continues after the stop is cleared. This functionality is only used for the label roll changing procedure in the subprogram LBLCHNG.SUB.

[WAITCN("LBL GET CONFIG")]
- Opens a dialog displaying all the configuration settings for the Datamax M-4206 printer if installed.

[WAITCN("LBL SET CONFIG P#")]
- Sets parameters for the Datamax M-4206 printer if installed. Multiple parameters and values should be separated by a semicolon. Refer to the Datamax Programmer's Manual.
  
  \( P \) - The parameter pneumonic to be set. A 2 or 3 character string.
  
  \# - The value for the parameter

[WAITCN("LBL RESET COUNTER")]
- Resets the counter on the Datamax M-4206 printer if installed.

[WAITCN("LBL UPDATE COUNTER")]
- Reads the current count from the Datamax M-4206 printer if installed and updated THM status based on the label settings in the Label Printer dialog.

[WAITCN("LBL GET SENSOR OUTPUT")]
- Opens a dialog displaying all the sensor values for the Datamax M-4206 printer if installed.

[WAITCN("M-I command")]
- Sends a command to Markem-Image 9040 printer if installed. This command is used to send a message for what to print when the appropriate output is triggered.
  
  \(-\) \textit{command} is a string containing the values recognized by the printer via CoLOS software provided by Markem-Image.

[WAITCN("DXFPRINTSUB")]
- Brings up dialog asking for a DXF. This DXF is read and TEMP_PRINT.SUB is created for indexing and printing notes contained in the DXF using Markem-Image 9040 printer.

[WAITCN("DXFPRINTSUB dxfpath")]
- Reads a DXF where \textit{dxfpath} contains the full path including file name and extension. TEMP_PRINT.SUB is created for indexing and printing notes contained in the DXF using Markem-Image 9040 printer.

[WAITCN("LOADLABELDATA")]
- Starts a process for reading the loaded program in THM. The program is scanned for comments containing values to create a database that may be used to print labels for auto
labeling. This technique is used by MasterCAM and SigmaNest to provide labeling data in the CNC program.
Manual Nesting

The Manual Nest function of Control Nesting allows the user to move parts within the nest freely or with constraints. Parts can also be copied, and pasted to a new sheet. To activate the toolbar for Manual Nest, select View, then Manual Nest Toolbar.

**Note:** If at any point while nesting manually, the **Nest** button is pressed, the entire nest will be reset.

1. Part selection
   a. Choose the icon
   b. Left click once on a part to select it.
   c. Hold down left click and draw a box around parts to select them.
   d. Press **Ctrl** + **A** to select all parts.
   e. Part colors
1. Green - Parts in green are those that do not interfere with other parts, and reside on the material completely.
2. Yellow - Parts in yellow either reside partially or entirely within another part or off the material.
3. Red - Parts in red reside entirely off the material.

2. Deselecting parts
   a. Choose the icon.
   b. Left click once on a part to deselect it.
   c. Press the key to deselect all parts.

3. Moving parts
   a. Move Constrained - Keeps toolpath distance between parts and the edge of the sheet. Parts cannot be moved off of the sheet. Moving constrained will only move parts that are green when selected.
      1. With a part selected (part(s) must be green when selected), choose the icon. Hold the left mouse button down and move the part. The part(s) will stop at the edge of another part or the edge of the sheet.
      2. Or, with a part(s) selected (part(s) must be green when selected), hold and while holding the right mouse button down, move the part(s). The part(s) will stop at the edge of another part or the edge of the sheet.
   b. Move Freely - Parts can be moved without respect to toolpath or sheet boundaries.
      1. With a part selected (selected part(s) can be any color), choose the icon. Hold the left mouse button down and move the part.
      2. Or, with a part(s) selected (selected part(s) can be any color), hold and while holding the right mouse button down, move the part(s).

4. Cut selected parts
   a. With a part(s) selected, choose the icon and the part(s) will be added to the clip
board.

b. Or, with a part(s) selected, press Ctrl + X and the part(s) will be added to the clipboard.

5. Copying selected parts

a. With a part(s) selected, choose the icon and the part(s) will be added to the clipboard.

b. Or, with a part(s) selected, press Ctrl + C and the part(s) will be added to the clipboard.

6. Paste parts.

a. Choose the icon and a dialog will open.
   1. Choose the part you would like to load from the clipboard list and press OK.

   2. To paste multiple parts from the list, hold Ctrl and left click to choose each part.
   3. To paste a section of parts from the list, select the beginning part of that section. Then, while holding Shift select the ending part.
   4. If only one part exists on the list, it will be chosen and pasted, bypassing the dialog box.

7. Add a new empty full sheet
   a. Adds a new blank sheet of the material currently being displayed.
1. To add a new blank sheet, choose the \[ \text{Insert} \] icon.

2. Or, press the \[ \text{Insert} \] key on the keyboard.
   a. New sheets will be added in after the last sheet of that material.
   b. Any blank or unused sheets will be removed when \[ \text{Write} \] is chosen.

8. Rotating selected parts
   a. Rotates a part(s) with respect to grain.
      1. Select a part or parts.
      2. Click on either side of the slider to rotate a part(s) in 45 degree increments.
      3. Or, left click and hold the slider and drag to the left or right.
      4. Or, left click in the box and type in a degree number.
   b. If a part has grain it will only be rotated at the 180 degree increment.

9. Calculate off-fall and/or labels
   a. After parts have been nested manually, labels and/or off-fall can be recalculated to maintain their function.
      1. To recalculate, choose the \[ \text{Alt} \] \[ \text{F11} \] icon.
      2. Or press \[ \text{Alt} \] \[ \text{F11} \]
Glossary

O

Off-fall: Usable scrap leftover from an operation.
Index

0
  0 119
  0.75 .............................................. 111
  1
    12
    value ...................................... 67
    12 ........................................... 67
  1p33x4_Address_Sheet.rpt ....................... 19
  1p33x4_Address_Sheet_Barcode.rpt .......... 19
  1p33x4_Address_Sheet_Recut.rpt ............ 19
  2
    2.5 ........................................... 111
    25 ........................................... 112
  2D parts
    outline layer .................................. 106
  2D parts ......................................... 106
  2x4_Shipping_Sheet.rpt ......................... 19
  2x4_Shipping_Sheet_Barcode.rpt ............. 19
  2x4_Shipping_Sheet_Recut.rpt ............... 19
  3
  30252_Address.rpt .............................. 19
  30252_Address_Barcode.rpt .................... 19
  30252_Address_Recut.rpt ....................... 19
  30252_Address_Symbol.rpt ...................... 19
  30252_Address_Symbol_Barcode.rpt .......... 19
  30256_Shipping.rpt ............................. 19
  30256_Shipping_Barcode.rpt .................. 19
  30256_Shipping_Recut.rpt ..................... 19
  30256_Shipping_Symbol.rpt .................... 19
  30256_Shipping_Symbol_Barcode.rpt .......... 19
  3rd
    cut ........................................... 59
  3rd ............................................ 59
  5
    50
      set ......................................... 57
    50 ........................................... 57
    50 ........................................... 74
    50 ........................................... 75
    5mm .......................................... 44, 52, 81
    5mm tool ...................................... 44
  9
    90°
      create ...................................... 63
    90° ........................................... 63
    90° ........................................... 92
  9-spindle
    use .......................................... 44
  9-spindle ...................................... 44
  9-spindle drill ................................ 44

A
  Accelerations
    Dove Tail Cutting ................................ 119
  Accelerations .................................... 119
  Accept Sheet ...................................... 93
  Action menu ....................................... 99
  Activate Timer .................................... 61
  Activate Timer .................................... 61
  Add .............................................. 10, 74
  Add DXF .......................................... 10
  Add files .......................................... 13
  Add Part Clearance ................................ 68
  Add Part Clearance ................................ 68
  Added
    altered ......................................... 92
    selecting ........................................ 87
  Added ............................................. 87
  Added ............................................. 90
  Added ............................................. 92
  Added ............................................. 93
  Added ............................................. 94
  Added ............................................. 95
  Added ............................................. 106
  Added ............................................. 110
  Added ............................................. 112
  Added ............................................. 114
  Added ............................................. 117
  Added ............................................. 127
  Added ............................................. 143
  Added Sheets
    Name ............................................. 92
  Added Sheets .......................... 39, 66, 67, 68, 87, 88
  Added Sheets ..................................... 92
  Added Sheets ..................................... 93
  Added Sheets ..................................... 95
  Added Sheets list ................................ 94
  Adding
    Sheets and/or Off-fall ......................... 87
  Adding .......................................... 14, 66, 67
  Adding .......................................... 87
  Adding .......................................... 88
  Address .......................................... 19, 37
  Adjust ........................................... 45, 57, 119
  Aggregate Time Check ........................... 44
  Aggregate Time Ck ................................ 45
  Aggregate Time Ck ................................ 45
  Air Assist ........................................ 49
  Air Assist Setup .................................. 49
  Air Assist Setup .................................. 49
  ALL .............................................. 90
Control Nesting Manual

All Materials
  selecting ............................................88
All Materials ......................................18, 53
All Materials ........................................88
Altered
  Added ................................................92
Altered ...........................................11, 14, 39, 43, 81
Altered ................................................92
Altered ............................................118
And/or .............................................46, 50, 90, 92, 123, 143
And/or OffFalls/Added Sheets .....................92
Apply ... 18, 19, 39, 51, 59, 63, 73, 75, 83, 92, 93,
  117, 119, 125
Apply button ......................................18, 93
Arc ...................................................53, 61, 63, 106
Auto Load and/or Unload
  operate .............................................50
Auto Load and/or Unload ..........................50
AutoCAD ..........................................106, 115
Automatically Run Off-Fall .......................39
Automatically Run Write CNC ....................39
Avery 5162 ...........................................19
Avery 5163 ...........................................19
Axis Shift ............................................45
B
Back ...............................................114
Backdado operation ................................114
Backdado z0p4375 ..................................114
Backdroid operation ......................114
Backdroid z#p ......................................106
Backdroid z0p5 .....................................114
Barcode
  contain ............................................55
  include ..........................................19
  scan .............................................55
  scanning .........................................87
Barcode .............................................16
Barcode .............................................19
Barcode ............................................55
Barcode ............................................87
Barcode ............................................95
Barcode ............................................95
Barcode ..........................................19, 137
Bitmaps .............................................19
Blind Dove Tail tool specifications ..........75
Blue .................................................35, 62, 63, 85, 111
Board/handling sheet .........................118
BOTH .................................................90
Buffer
  Deviation Check ...................................63
Buffer ..............................................63
Build .................................................81, 123, 125
C
Cabinet Solutions ..................................115
Cabinet Vision ...................................105, 115
CabinetVision ......................................6
CabinetWare ........................................6
CAD ...................................................105
CAD/CAM ...........................................4, 113
CADKEY .............................................115
Cause
  Material dialog ...................................39
Cause ................................................17, 33
Cause ................................................39
Cause .................................................67
Cause ................................................68
Cause .................................................69
Cause ................................................106
Cause ................................................119
Centerline .........................................111
Centerline ..........................................57, 106
Centerline ..........................................111
Centerline ..........................................112
Centerline ..........................................112
Centerline ..........................................114
Centerline d0p375 z0p75 .........................111
Centerline d0p75 z1p5 ...........................106
Centerline z#p .....................................106
Centerline1 z0p75 d0p5 ......................110, 112
Centerline2 z0p82 d0p25 ......................110, 112
Centerline3 z0p85 d0p125 .....................110, 112
Chain ...............................................106, 110, 112, 114
Chain compin .....................................106
Chain compin1 z0p75 d0p5 ......................110
Chain compout ....................................106
Chain compout z#p ................................106
Chain Layer ........................................110, 112
Chaincompin ......................................112
Chaincompin d0p375 z0p125 ....................112
Chaincompin/out ................................106
Chaincompout ......................................112
Chaincompout d0p25 z0p125 ....................112
Change
  Name .................................................88
OffFall .............................................93
Change ..............................................10, 38, 43, 44, 46, 83
Change .............................................88
Change .................................................92
Change .................................................93
Change ...............................................105
Change ..............................................117
Change ..............................................112
Change ..............................................119
Change ...............................................138
Checking
  Use ................................................121
Checking ..........................................121
Choose .10, 18, 41, 45, 48, 49, 50, 51, 58, 74, 75,
  91, 143
Ck Waste Board Every Sheet .....................45
Ck Waste Board Every Sheet .....................45
Clean Up Amount ..................................52
Cleanup .............................................52, 57
Clear ................................................10, 17, 45, 55, 94, 138
| Clear All                        | 10, 17       | Contain                                    | 137       |
| Clear All                        | 10          | Contain                                    | 138       |
| Clear All                        | 17          | Control                                    | 7         |
| Clear All                        | 55          | Control exiting                            | 74        |
| Clear button                      | 94          | Control re-staring                         | 85        |
| Clicking                         |             | Control running                            | 37        |
| Clicking                         | 58          | Control starting                           | 4         |
| Clicking                         | 71          | Control 4                                 | 4         |
| Clicking                         | 71          | Control 6                                 | 6         |
| Clicking                         | 74          | Control 10                                | 10        |
| Clicking                         | 81          | Control 11                                | 11        |
| Clicking                         | 92          | Control 13                                | 13        |
| Climb                            | 54, 55, 119 | Control 14                                | 14        |
| CLOSEST                          | 48          | Control 19                                | 19        |
| CNC                              |             | Control 33                                | 33        |
| CNC                              | 103         | Control 33                                | 33        |
| CNC                              | 113         | Control 37                                | 37        |
| CNC                              | 114         | Control 39                                | 39        |
| CNC                              | 117         | Control 43                                | 43        |
| CNC                              | 125         | Control 44                                | 44        |
| CNC                              | 130         | Control 45                                | 45        |
| CNC                              | 137         | Control 48                                | 48        |
| CNC                              | 138         | Control 49                                | 49        |
| CNC machining                     | 117         | Control 50                                | 50        |
| Collar                           | 68          | Control 52                                | 52        |
| Collar                           | 66          | Control 53                                | 53        |
| Collar                           | 68          | Control 54                                | 54        |
| Collar                           | 70          | Control 54                                | 54        |
| Colors                           | 35, 62, 111, 113, 143 | Control 55                                | 55        |
| Compin                           | 106, 110   | Control 57                                | 57        |
| Compout                          | 106, 110   | Control 57                                | 57        |
| Confirmation Screen              | 79          | Control 58                                | 58        |
| Confirmation Screen              | 79          | Control 61                                | 61        |
| Contact Thermwood                | 115         | Control 62                                | 62        |
| Contain                          |             | Control 63                                | 63        |
| Contain                          | 2.5         | Control 67                                | 67        |
| Contain                          | 55          | Control 67                                | 67        |
| Contain                          | 92          | Control 69                                | 69        |
| Contain                          | 6, 9, 10, 11, 14, 19, 33, 43, 49 | Control 70                                | 70        |
| Contain                          | 70          | Control 70                                | 70        |
| Contain                          | 75          | Control 70                                | 70        |
| Contain                          | 92          | Control 70                                | 70        |
| Contain                          | 106         | Control 72                                | 72        |
| Contain                          | 110         | Control 72                                | 72        |
| Contain                          | 111         | Control 74                                | 74        |
| Contain                          | 112         | Control 74                                | 74        |
| Contain                          | 113         | Control 75                                | 75        |
| Contain                          | 130         | Control 80                                | 80        |

Index
Control Nesting Manual

Control.................................................84
Control.................................................85
Control.................................................88
Control.................................................91
Control.................................................91
Control.................................................93
Control.................................................94
Control.................................................95
Control.................................................99
Control.................................................103
Control.................................................105
Control.................................................106
Control.................................................106
Control.................................................110
Control.................................................110
Control.................................................111
Control.................................................111
Control.................................................112
Control.................................................112
Control.................................................113
Control.................................................119
Control.................................................121
Control.................................................123
Control.................................................125
Control.................................................127
Control.................................................128
Control.................................................130
Control.................................................132
Control.................................................134
Control.................................................137
Control.................................................137
Control.................................................138
Control.................................................143
Control Nesting .....................................143
Corner.................................................83
Corner.................................................85
Corner.................................................91
Corner.................................................117
Corner.................................................119
Corner.................................................130
Corner Angle .......................................117
Corner Radius.......................................117
Counter-clockwise ..................................92
CPOUT..................................................13
Creating
90°......................................................63
DXF.....................................................10, 110
Void.....................................................91
Creating.................................................10
Creating...............................................63
Creating...............................................91
Creating...............................................110
Crystal Report file ...................................19, 55
Ctrl......................................................10, 81, 90
Ctrl key
hold.....................................................90
Ctrl key..................................................81
Ctrl key..................................................90
Ctrl-C....................................................74
Ctrl-V....................................................74
Current Tool Names button ................................6, 75
Currently, Rolling Nest....................................74
Cut
3rd......................................................59
Cut ......................................................61
Cut ......................................................61
Cut......................................................62
Cut......................................................62
Cut......................................................62
Cut......................................................63
Cut......................................................67
Cut......................................................74
Cut......................................................75
Cut......................................................81
Cut......................................................99
Cut.....................................................103
Cut.....................................................106
Cut.....................................................106
Cut.....................................................110
Cut.....................................................111
Cut.....................................................111
Cut.....................................................112
Cut.....................................................112
Cut.....................................................112
Cut.....................................................113
Cut.....................................................113
Cut.....................................................114
Index

Files
  Loading ........................................... 9
Files .................................................. 4, 6
Files .................................................. 9
Files .................................................. 10
Files .................................................. 10
Files .................................................. 11
Files .................................................. 13
Files .................................................. 14
Files .................................................. 19
Files .................................................. 33
Files .................................................. 33
Files .................................................. 38
Files .................................................. 41
Files .................................................. 55
Files .................................................. 70
Files .................................................. 71
Files .................................................. 103
Files .................................................. 105
Files .................................................. 106
Files .................................................. 110
Files .................................................. 111
Files .................................................. 112
Files .................................................. 113
Files .................................................. 114
Files .................................................. 115
Files .................................................. 125
Files .................................................. 127
Files .................................................. 130
Files .................................................. 137
Files .................................................. 138
Files containing
  list .................................................. 14
Files containing .................................... 14
Fit Clearance ....................................... 117
Flip Op Fence ...................................... 48
Flip Operations ................................. 17, 48, 59, 83, 114
Flip Ops First ................................. .59, 70
Follow a centerline ................................ 111
Format ............................................. 41
Format ............................................. 7
Format ............................................. 41
Format ............................................. 105
Format ............................................. 106
Format ............................................. 113
Format ............................................. 137
From Ends ........................................... 63
Front Page ......................................... 1
FSH1065 ............................................. 117
Full Feed
  Through Cuts ...................................... 57
  Full Feed ......................................... 57
G
G52L5 .................................................. 45
G901 .................................................. 48
G901 Location ...................................... 48
G902 .................................................. 114
Get
  Double Pass ...................................... 58
Get ................................................... 10, 19
Get ................................................... 58
Get ................................................... 62
Get ................................................... 75
Get ................................................... 87
Get ................................................... 92
Get ................................................... 121
Group
  Copy/Paste ....................................... 74
  Tooling ............................................ 74
Group .................................................. 33, 38, 66, 70
Group .................................................. 74
Group .................................................. 74
Group .................................................. 74
Group .................................................. 74
Group .................................................. 121
Group .................................................. 123
Group Materials ................................... 74
Group Materials ................................... 74
Group setting ...................................... 74
H
Hardcode ............................................ 105
Hbore ............................................... 106
He/she ............................................. 10, 17
Hold
  Ctrl key .......................................... 90
Hold .................................................. 10, 33, 43, 62, 68, 81, 85
Hold .................................................. 90
Hold .................................................. 95
Hold .................................................. 143
HOME ................................................. 45
I
I/O’s .................................................. 48
ID/Name ............................................. 92
IE 106  .................................................
Ignore Boundaries ................................ 48
Ignore Groups ..................................... 74
Ignore Groups ..................................... 74
Imperial ............................................. 113
Implement  Load ...................................... 50
Unload ............................................. 50
Implement ......................................... 50
Include
  barcode ............................................. 19
Include ............................................. 1, 10
Include ............................................. 19
Include ............................................. 57
Include ............................................. 59
Include ............................................. 66
Include ............................................. 105
Include ............................................. 138

143
<table>
<thead>
<tr>
<th>Index</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicates</td>
<td>106, 110</td>
</tr>
<tr>
<td>Indicates dado</td>
<td>106</td>
</tr>
<tr>
<td>Indicates outline/through</td>
<td>106</td>
</tr>
<tr>
<td>Indicates pocket</td>
<td>106</td>
</tr>
<tr>
<td>Inset Carvings</td>
<td>125</td>
</tr>
<tr>
<td>Intellilac</td>
<td>115</td>
</tr>
<tr>
<td>Interpolate</td>
<td>75</td>
</tr>
<tr>
<td>Introduction</td>
<td>1, 105</td>
</tr>
<tr>
<td>IPM</td>
<td>57</td>
</tr>
<tr>
<td>Isn’t</td>
<td>112</td>
</tr>
<tr>
<td>It’s</td>
<td>106</td>
</tr>
<tr>
<td>level/layer</td>
<td>106</td>
</tr>
<tr>
<td>It’s’s</td>
<td>106</td>
</tr>
<tr>
<td>Item</td>
<td>92</td>
</tr>
<tr>
<td>Load</td>
<td>18, 33, 35, 88, 90</td>
</tr>
<tr>
<td>Item</td>
<td>92</td>
</tr>
<tr>
<td>Item</td>
<td>93</td>
</tr>
<tr>
<td>Item</td>
<td>94</td>
</tr>
<tr>
<td>Item</td>
<td>94</td>
</tr>
<tr>
<td>Item</td>
<td>94</td>
</tr>
<tr>
<td>J</td>
<td>6</td>
</tr>
<tr>
<td>Job Level Interface</td>
<td>6</td>
</tr>
<tr>
<td>K</td>
<td>6, 115</td>
</tr>
<tr>
<td>KCDw</td>
<td>115</td>
</tr>
<tr>
<td>Kcdw.dxf</td>
<td>53</td>
</tr>
<tr>
<td>Keep Recut History</td>
<td>55</td>
</tr>
<tr>
<td>L</td>
<td>1</td>
</tr>
<tr>
<td>L.E.</td>
<td>71, 128, 137</td>
</tr>
<tr>
<td>Label Recovery dialog</td>
<td>71, 128, 137</td>
</tr>
<tr>
<td>Label Type</td>
<td>19</td>
</tr>
<tr>
<td>Labels</td>
<td>19</td>
</tr>
<tr>
<td>Printing</td>
<td>19</td>
</tr>
<tr>
<td>Labels</td>
<td>16</td>
</tr>
<tr>
<td>Labels</td>
<td>19</td>
</tr>
<tr>
<td>Labels</td>
<td>39</td>
</tr>
<tr>
<td>Labels</td>
<td>55</td>
</tr>
<tr>
<td>Labels</td>
<td>71</td>
</tr>
<tr>
<td>Labels</td>
<td>90</td>
</tr>
<tr>
<td>Labels</td>
<td>123</td>
</tr>
<tr>
<td>Labels</td>
<td>127</td>
</tr>
<tr>
<td>Labels</td>
<td>127</td>
</tr>
<tr>
<td>Labels</td>
<td>128</td>
</tr>
<tr>
<td>Labels</td>
<td>130</td>
</tr>
<tr>
<td>Labels</td>
<td>132</td>
</tr>
<tr>
<td>Labels</td>
<td>134</td>
</tr>
<tr>
<td>Labels</td>
<td>137</td>
</tr>
<tr>
<td>Labels</td>
<td>138</td>
</tr>
<tr>
<td>Labels</td>
<td>143</td>
</tr>
<tr>
<td>Laser</td>
<td>19</td>
</tr>
<tr>
<td>Last Line Feed Speed</td>
<td>57</td>
</tr>
<tr>
<td>Last Line Feed Speed</td>
<td>57</td>
</tr>
<tr>
<td>Last Updated</td>
<td>1</td>
</tr>
<tr>
<td>Layer Names</td>
<td>106</td>
</tr>
<tr>
<td>Defining</td>
<td>106</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Index</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layer Names</td>
<td>106</td>
</tr>
<tr>
<td>Layer Names</td>
<td>106</td>
</tr>
<tr>
<td>Layer Names</td>
<td>106</td>
</tr>
<tr>
<td>Layer Names</td>
<td>110</td>
</tr>
<tr>
<td>Layer Names</td>
<td>111</td>
</tr>
<tr>
<td>Layer Names</td>
<td>111</td>
</tr>
<tr>
<td>Layer Names</td>
<td>112</td>
</tr>
<tr>
<td>Layer Names</td>
<td>114</td>
</tr>
<tr>
<td>Layer’s</td>
<td>110</td>
</tr>
<tr>
<td>Layer’s</td>
<td>110</td>
</tr>
<tr>
<td>Layers.dxf</td>
<td>113</td>
</tr>
<tr>
<td>Leave Skin</td>
<td>58</td>
</tr>
<tr>
<td>Leave Skin</td>
<td>58</td>
</tr>
<tr>
<td>Leftover Area</td>
<td>52, 75</td>
</tr>
<tr>
<td>Length</td>
<td>91</td>
</tr>
<tr>
<td>Length Axis</td>
<td>41</td>
</tr>
<tr>
<td>Let’s</td>
<td>111, 113</td>
</tr>
<tr>
<td>Letter</td>
<td>45, 106, 111</td>
</tr>
<tr>
<td>Level Manager Example</td>
<td>113</td>
</tr>
<tr>
<td>Level Manger</td>
<td>113</td>
</tr>
<tr>
<td>Level/layer</td>
<td>106</td>
</tr>
<tr>
<td>it’s’s</td>
<td>106</td>
</tr>
<tr>
<td>Level/layer</td>
<td>106</td>
</tr>
<tr>
<td>Line</td>
<td>10, 46, 47, 53, 57, 99, 106, 130</td>
</tr>
<tr>
<td>Line containing</td>
<td>10</td>
</tr>
<tr>
<td>parts</td>
<td>10</td>
</tr>
<tr>
<td>Line containing</td>
<td>10</td>
</tr>
<tr>
<td>List</td>
<td>14</td>
</tr>
<tr>
<td>files containing</td>
<td>14</td>
</tr>
<tr>
<td>List</td>
<td>17</td>
</tr>
<tr>
<td>List</td>
<td>18</td>
</tr>
<tr>
<td>List</td>
<td>19</td>
</tr>
<tr>
<td>List</td>
<td>52</td>
</tr>
<tr>
<td>List</td>
<td>69</td>
</tr>
<tr>
<td>List</td>
<td>74</td>
</tr>
<tr>
<td>List</td>
<td>75</td>
</tr>
<tr>
<td>List</td>
<td>84</td>
</tr>
<tr>
<td>List</td>
<td>88</td>
</tr>
<tr>
<td>List</td>
<td>90</td>
</tr>
<tr>
<td>List</td>
<td>90</td>
</tr>
<tr>
<td>List</td>
<td>90</td>
</tr>
<tr>
<td>List</td>
<td>92</td>
</tr>
<tr>
<td>List</td>
<td>93</td>
</tr>
<tr>
<td>List</td>
<td>93</td>
</tr>
<tr>
<td>List</td>
<td>94</td>
</tr>
<tr>
<td>List</td>
<td>94</td>
</tr>
<tr>
<td>List</td>
<td>94</td>
</tr>
<tr>
<td>List</td>
<td>94</td>
</tr>
<tr>
<td>List</td>
<td>105</td>
</tr>
<tr>
<td>List</td>
<td>106</td>
</tr>
<tr>
<td>List</td>
<td>143</td>
</tr>
<tr>
<td>Load</td>
<td>9</td>
</tr>
</tbody>
</table>

Page 144
Control Nesting Manual

Name 6, 10, 11, 14, 19, 38, 41, 42, 55, 66, 70, 71, 74, 75, 81, 87
Name .............................................. 88
Name .............................................. 91
Name .............................................. 92
Name .............................................. 94
Name .............................................. 94
Name ............................................. 105
Name ............................................. 106
Name ............................................. 106
Name ............................................. 106
Name ............................................. 110
Name ............................................. 111
Name ............................................. 112
Name ............................................. 112
Name ............................................. 112
Name ............................................. 113
Name ............................................. 127
Name ............................................. 138
Name – This ...................................... 106
Name d#p .......................................... 106
Nest
Edge ............................................. 70
Parameters ..................................... 66
Nest.... 1, 4, 6, 7, 9, 10, 11, 13, 14, 17, 18, 19, 33, 35, 37, 39, 41, 43, 44, 45, 48, 49, 50, 51, 52, 54, 55, 57, 58, 59, 61, 62, 63
Nest ............................................. 66
Nest ............................................. 67
Nest ............................................. 67
Nest ............................................. 68
Nest ............................................. 68
Nest ............................................. 69
Nest ............................................. 69
Nest ............................................. 70
Nest ............................................. 70
Nest ............................................. 70
Nest ............................................. 70
Nest ............................................. 72
Nest ............................................. 73
Nest ............................................. 74
Nest ............................................. 74
Nest ............................................. 74
Nest ............................................. 75
Nest ............................................. 79
Nest ............................................. 80
Nest ............................................. 83
Nest ............................................. 84
Nest ............................................. 84
Nest ............................................. 85
Nest ............................................. 87
Nest ............................................. 88
Nest ............................................. 90
Nest ............................................. 91
Nest ............................................. 91
Nest ............................................. 92
Nest ............................................. 93
Nest ............................................. 93
Nest ............................................. 94
Nest ............................................. 94
Nest ............................................. 94
Nest ............................................. 95
Nest ............................................. 99
Nest ........................................... 103
Nest ........................................... 105
Nest ........................................... 106
Nest ........................................... 106
Nest ........................................... 106
Nest ........................................... 110
Nest ........................................... 110
Nest ........................................... 111
Nest ........................................... 111
Nest ........................................... 112
Nest ........................................... 111
Nest ........................................... 112
Nest ........................................... 112
Nest ........................................... 112
Nest ........................................... 113
Nest ........................................... 119
Nest ........................................... 121
Nest ........................................... 123
Nest ........................................... 125
Nest ........................................... 127
Nest ........................................... 128
Nest ........................................... 130
Nest ........................................... 137
Nest ........................................... 137
Nest ........................................... 138
Nest ........................................... 143
Nest Direction .................................. 66
Nest/Labels
Rolling .......................................... 19
Nest/Labels ...................................... 19
Nest/SheetImages
Rolling .......................................... 19
Nest/SheetImages ................................ 19
Nesting analyzes ............................... 62
Nesting Capabilities ............................ 105
Nesting DXF ..................................... 4, 41
Nesting Parameters ............................ 66
Nesting TWD files ............................... 41
New ... 10, 33, 45, 63, 68, 69, 81, 88, 92, 93, 127, 143
New button ..................................... 93
New Sheets ...................................... 45, 68, 143
Non-Quick Cut Jobs ............................ 39
NOT ........... 17, 54, 68, 90, 92, 94, 132, 137, 138
NOTE ... 19, 90, 91, 111, 112, 123, 127, 132, 134, 137, 138
Now Control Nesting ......................... 6, 75
Number .... 38, 45, 49, 50, 55, 70, 75, 90, 91, 99, 110, 112, 118, 121, 137, 138, 143
O
Off Fall ......................................... 67
Square .......................................... 67
Index

Off Fall ........................................... 62
Off Fall ........................................... 67
Off Fall Cuts ..................................... 62
OffFall change .................................... 93
OffFall ............................................. 33, 92
Off-Fall ........................................... 1, 4
Off-Fall ........................................... 39
Off-Fall ........................................... 59
Off-Fall ........................................... 62
Off-Fall ........................................... 66
Off-Fall ........................................... 67
Off-Fall ........................................... 68
Off-Fall ........................................... 69
Off-Fall ........................................... 69
Off-Fall ........................................... 70
Off-Fall ........................................... 87
Off-Fall ........................................... 90
Off-Fall ........................................... 93
Off-Fall ........................................... 94
Off-Fall ........................................... 95
Off-Fall ........................................... 143
Off-Fall ID contain ................................ 92
Off-Fall ID ........................................ 92
Off-fall Library ................................... 87, 88
Off-Fall Sheets ................................... 69
OffFall/Added Sheets .............................. 90
Offfalls ........................................... 90
Offfalls and/or Added Sheets ................... 90
OffFall/Added Sheets ............................. 88
Offfalls/Added Sheets dialog .................... 93
Offfalls/Saved clicking ........................... 92
Offfalls/Saved ................................... 88
Offfalls/Saved ................................... 92
Offfalls/Added Sheets ............................ 93
Offfalls/Saved ................................... 94
Offfalls/Saved Sheets ............................. 88
Offfalls/Saved Sheets dialog ..................... 93, 94
OK .................................................. 10, 74, 127
OL100WR .......................................... 19
OL125WR .......................................... 19
On/off ............................................. 48
Only Use Added/Off-Fall Sheets ................ 69
Operate Auto Load and/or Unload .............. 50
Operate ............................................. 37, 42, 48, 49
Operate ............................................. 50
Operate ............................................. 130
Operate ............................................. 132
Operation Order .................................... 112
Operation, 4, 6, 17, 45, 47, 48, 52, 53, 55, 57, 58, 59, 61, 62, 66, 67, 68, 70, 72, 73, 74, 75, 81, 90, 105, 106, 110, 111
Operation .......................................... 112
Operation .......................................... 113
Operation .......................................... 114
Operation .......................................... 115
Operation .......................................... 119
Operation .......................................... 121
Operation .......................................... 130
Operation .......................................... 134
Operation .......................................... 138
Operation calls tool ................................ 73
Operation calls .................................... 73
Operation Tool .................................... 6, 75, 121
OPPOSITE ........................................ 48
Ops .................................................. 59
Order Operations ................................... 112
Order .............................................. 10, 37, 58, 59, 75, 94, 105, 110, 111
Order .............................................. 112
Outline ............................................ 110
Outline .... 17, 55, 58, 61, 62, 67, 70, 74, 105, 106
Outline ............................................ 110
Outline ............................................ 111
Outline ............................................ 119
Outline Cuts ...................................... 62, 119
Outline layer 2D parts ............................ 106
Outline layer ...................................... 106
Outline layer ...................................... 106
Outline layer ...................................... 110
Outline layer ...................................... 111
Outline Order ..................................... 58
Outline Order ..................................... 58
Outline Pre-Ramp Depth .......................... 57
Outline Tool Setup ................................ 74
Outline Tool Setup ................................ 74
Outline z#p ........................................ 106
Outline z0p75 ...................................... 111
P
P 106, 111
Pan .................................................. 85
Parameters
  Nesting .......................................... 66
Parameters ........................................ 16, 41, 51, 54, 62, 63
Parameters ........................................ 66
Parameters ........................................ 84
Parameters ........................................ 99
Parameters ........................................ 117
Parameters ........................................ 119
Parameters ........................................ 138
Part containing ................................... 110
Part Editor ........................................ 61, 123
Part Rotation Step Angle ........................ 70
Part Rotation Step Angle ........................ 17
Part Rotation Step Angle ........................ 70
Size .................................................................................. 66
Size .................................................................................. 67
Size .................................................................................. 75
Size .................................................................................. 81
Size .................................................................................. 85
Size .................................................................................. 111
Size .................................................................................. 127
Size .................................................................................. 138
Skin Thickness ..................................................................... 58, 119
Smallest ............................................................................. 52, 67, 75
Software Packages
  Unique Requirements ......................................................... 115
Software Packages ............................................................. 105
Software Packages ............................................................. 115
Specifications ................................................................... 4, 10, 75
Spindle Speed ..................................................................... 74, 75
Spiral .................................................................................. 51
Square
  Off Fall ............................................................................. 67
Square .............................................................................. 57, 58, 59
Square .............................................................................. 67
Square .............................................................................. 69
Starting
  Control .............................................................................. 4
  Corner ................................................................................ 68
Starting .............................................................................. 4
Starting .............................................................................. 68
Starting Corner ................................................................. 66, 68, 99
Step Percentage .................................................................. 75
Stipulations ......................................................................... 110, 114
Style Changer .................................................................... 44
Suit
  user’s ................................................................................ 1
Suit ..................................................................................... 1
Super Control ..................................................................... 105
Super Control’s Tool Table ............................................... 74
T
  Tab .................................................................................... 63
  Tab Parameters ................................................................... 63
  Tab Thickness ..................................................................... 63
  Tab Width .......................................................................... 63
  Tabbing ............................................................................. 63
    Parts ................................................................................ 62
    Tabbing .......................................................................... 62
Table ................................................................................. 41, 43, 45, 48, 49, 52, 59, 63, 74, 91, 118, 132, 134
Table Parameters .................................................................. 41
Table Parameters .................................................................. 41
Tabs ................................................................................... 62, 63, 81, 117, 127
Tabs button ......................................................................... 62
Thermwood CNC Rental Application ................................. 125
Thermwood Control Prior
  Tool Management ................................................................ 72
Thermwood Control Prior .................................................. 72
Thermwood Controller ....................................................... 39, 113
Thermwood Software ........................................................ 1, 4, 103
Thermwood Super Control ................................................ 111
Thermwood SuperControl’s tool ........................................ 118
Thermwood’s Control Nesting ............................................ 105
Thermwood’s Control Nesting Software ............................ 106
Thermwood’s Tool Table ................................................... 74
Thickness ........................................................................... 39, 41, 45, 63, 81, 106, 111, 114, 117
THM ................................................................................. 4, 19, 39, 55, 71, 75, 110, 123, 125, 127, 128, 132, 134, 138
THM Options ........................................................................ 4
Through Cuts ....................................................................... 57
  Full Feed .......................................................................... 57
Through Cuts ....................................................................... 53
Through Cuts ....................................................................... 57
Through Cuts ....................................................................... 75
Through Cuts ....................................................................... 111
Through Cuts ....................................................................... 111
Tolerance ............................................................................ 43, 73
Tool Management
  Thermwood Control Prior ................................................ 72
  Tool Management ................................................................ 72
  Tool Management ................................................................ 74
  Tool Management ................................................................ 75
  Tool Manager ..................................................................... 110, 111
  Tool Names ......................................................................... 6, 75, 81, 106
  Tool’s uses ......................................................................... 74
  Tool’s ................................................................................ 74
  Tool’s .............................................................................. 118
  Tooling ............................................................................. 79, 110
    Group ................................................................................ 74
    operation calls .................................................................. 73
    Use ................................................................................ 52
    Tooling .............................................................................. 6
    Tooling .............................................................................. 52
    Tooling .............................................................................. 73
    Tooling .............................................................................. 74
    Tooling .............................................................................. 75
    Tooling ............................................................................. 106
    Tooling button
      select ............................................................................ 121
    Tooling button .................................................................. 121
    Toolname .......................................................................... 106
    Toolpath ............................................................................ 111, 143
    Toolpaths .......................................................................... 106
    Top .................................................................................. 4, 50, 63, 91, 106, 111, 114, 118, 123, 132, 134
    Trim Sheet ......................................................................... 59
    True Shape ......................................................................... 99
    Turbo Cab .......................................................................... 115
    Tutorial ............................................................................. 105, 110, 113
Control Nesting Manual

Twd
  loading ........................................... 10, 17
Twd.................................................. 4, 6
Twd.................................................. 10
Twd.................................................. 10
Twd.................................................. 17
Twd.................................................. 38
Twd.................................................. 99
Twd.................................................. 137
TWD file............................................ 4
TWD Files......................................... 10
Type.................................................. 75

U
Undo................................................... 91
Undo button......................................... 91
Unique Requirements
  Software Packages............................... 115
Unique Requirements............................. 115
Unload
  implement .......................................... 50
Unload................................................ 49
Unload................................................ 50
Until Control Nesting............................. 123
Use Part Name on Parts........................... 19
Use Unlock.......................................... 50
User Manual........................................ 1
User’s
  suit ................................................ 1
User’s ............................................... 1
Uses
  9-spindle ......................................... 44
  checking .......................................... 121
  Male Routs ........................................ 75
  Tool ................................................ 52
  tool’s ............................................. 74
Uses................................................... 10, 19, 33, 38, 39, 43
Uses................................................... 44
Uses................................................... 45
Uses................................................... 45
Uses................................................... 45
Uses................................................... 48
Uses................................................... 49
Uses................................................... 49
Uses................................................... 49
Uses................................................... 50
Uses................................................... 52
Uses................................................... 59
Uses................................................... 61
Uses................................................... 62
Uses................................................... 63
Uses................................................... 67
Uses................................................... 67
Uses................................................... 69
Uses................................................... 73
Uses................................................... 74
Uses................................................... 74
Uses................................................... 74

Uses .................................................. 74
Uses .................................................. 75
Uses .................................................. 81
Uses .................................................. 81
Uses .................................................. 84
Uses .................................................. 91
Uses .................................................. 93
Uses .................................................. 94
Uses .................................................. 94
Uses .................................................. 95
Uses .................................................. 105
Uses .................................................. 110
Uses .................................................. 110
Uses .................................................. 111
Uses .................................................. 111
Uses .................................................. 112
Uses .................................................. 112
Uses .................................................. 112
Uses .................................................. 114
Uses .................................................. 119
Uses .................................................. 121
Uses .................................................. 123
Uses .................................................. 128
Uses .................................................. 130

V
Value
  0 119
  12 ............................................... 67
Value 7, 11, 14, 19, 35, 38, 41, 43, 48, 50, 51, 52, 57, 58, 59, 63, 66
Value ................................................. 67
Value ................................................. 67
Value ................................................. 68
Value ................................................. 69
Value ................................................. 70
Value ................................................. 73
Value ................................................. 75
Value ................................................. 84
Value ................................................. 92
Value ................................................. 106
Value ................................................. 106
Value ................................................. 117
Value ................................................. 118
Value ................................................. 119
Value ................................................. 127
Value ................................................. 130
Value ................................................. 137
Value ................................................. 137
Value ................................................. 138
Value ................................................. 115
VectorWorks........................................ 115
Version 5.x......................................... 1
Version Requirements......................... 123, 125
Void Entry.......................................... 91
Void Entry.......................................... 91
Index

Voids
created..................................91
Voids ......................................91
W
Wait .......................................48
Wasteboard ..........................41, 45, 114
Width .....................................91
Width/length ............................58
Window
Print ......................................19
Window ......................................4, 9, 10
Window ......................................19
Window ......................................74
Window ......................................85
Window ......................................85
Window ......................................91
Window ......................................93
Window ......................................94
Window .....................................123
Window .....................................125
Window’s ...................................10
Windows menu .............................4
Windows Picture Viewer .................19
Windows XP ...............................123, 125
Wish
Merge ......................................81
Paste ........................................74
Wish ..................................35, 39, 58, 67, 71, 74
Wish .........................................74
Wish ..........................................74
Wish ..........................................74
Wish ..........................................75
Wish ..........................................81
Wish ..........................................84
Wish ..........................................91
Wish ..........................................106
Write
clicking ....................................71
Write ..................................39, 41, 44, 49, 50, 61
Write .......................................71
Write ..........................................103
Write ..........................................127
Write CNC ...................................103
WRITE CNC ....................................39
Writing
CNC ..........................................103
Writing ......................................103
Www.OnlineLabels.com .................19
X
Xshift .........................................48
Y
Yshift .........................................48
Z
Z#p ...........................................106
Z0p75 .........................................111
Zigzag .......................................51
Zig-zag .......................................112
Zoom .........................................85